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A. Preface

Purpose

This document describes the functionality and procedures involved in using the EVE Screen
Designer (ESD).

Intended Audience

The intended audience shall be any GUI application developer working with EVE products.

Document Reference

Document Name Document Type Document Format
FT81x Series Programmers Guide Programming Guide PDF
FT81x Datasheet Datasheet PDF
FT9xx Toolchain Installation Guide Installation Guide PDF
BT81X Series Programming Guide Programming Guide PDF
BT81X (815/6) Datasheet Datasheet PDF
BT817/8 Datasheet Datasheet PDF

Feedback

Every effort has been taken to ensure that the document is accurate and complete.
However, any feedback on the document may be emailed to docufeedback@brtchip.com.
For any additional technical support, refer to http://brtchip.com/contact-us/.
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B. Overview

Introduction

EVE Screen Designer (ESD) is the next generation of smart IDE for EVE, making EVE-
based GUI development much easier to accomplish. This tool enables users to build one
GUI application using a visual programming! method without needing to know any EVE-
specific display list commands.

ESD provides a WYSIWYG ("What You See Is What You Get”) environment for editing
graphics, designing visual effects, and defining GUI application user logic,
generating ANSI C code for the targeted hardware platform. Users can also choose to
simulate the whole design to experience the UI before compiling and downloading the
generated source code. Furthermore, ESD has the capability to work seamlessly with
Bridgetek FT9XX Toolchain. Users can compile, link the generated source code with FT9XX
Toolchain and upload it to the targeted platform without leaving ESD. From 4.13 onward,
ESD has the same capability as FT90X platform to work with Raspberry Pi Pico2. From
4.19 onward, ESD also supports the STM32F4 platform, similar to the FT90X platform.

A layout mechanism is introduced to manage widgets and pages in a more generic way.
The layout mechanism will enable users to create more dynamic Ul much easier than
before. In addition, ESD 4.14 dramatically enhances the functionality of the logic nodes
editor, layout editor and project browser, for better user experience.

Key Features

The following are some of the key features of EVE Screen Designer:

WYSIWYG GUI

High level widgets

No EVE display list knowledge required

Widget based GUI construction

Drag and drop widget to create screen layout

Inter widget communication

Screen logic creation without coding

Simulation of screen logic and user touch input using mouse

Building and downloading the generated “"C"” code (if FT9XX/STM32CubelDE/Pico
Toolchain is installed)

FEFEEREEEFRFE

What's new in ESD 4.19

New Features:

#+ Improved widget functionality by enabling the selection of the corresponding radio
button and checkbox widget through text-clicking.

#+ Added Scrolling Text Widget.

# Resolved the issue causing crashes in the ESD application when adding an ESD
Input and selecting the 'esd_fonticon_t' type.

1 https://en.wikipedia.org/wiki/Visual programming language
2 https://www.raspberrypi.org/products/raspberry-pi-pico/
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#+ Fixed the issue where the Text Input on the Property Browser was unable to input
the '/' and '\' characters.

4+ Removed the redefined names and unnecessary definition names from some
example projects .esd file.

4+ Fixed the Font Icon search function not recognizing case sensitivity.

4+ Replaced the graphics definitions EVE_GRAPHICS_VM816C50A and
EVE_GRAPHICS_VM816CU50A with EVE_GRAPHICS_VM816C in the Target.conf
file.

+ Added Image Slideshow widget.

4+ Added QRCode to basic example projects.

#+ Moved .esdm files to a separate folder in the project folder.

4+ Added options for Gauge Widget: OPT_NOBACK , OPT_NOTICKS, OPT_NOPOINTER.

4+ Improved example project "AdvancedWidgetsDemo".

4+ Added support for STM32 platform.

# Resolved the issue preventing renaming of the 'Usr_Page' name in the project
browser when creating a new project.

4+ Added the EVE flash memory feature into STM32 board.

4+ Added an example project for the STM32F4 platform named CoverFlow.

4+ Created Dynamic Array Input.

4+ Added e-Bike example project.

Known Issues & Limitations

The following are some known issues and limitations of ESD:

= Only the BT81X/BT88x/FT81X series EVE is supported. FT80X Series EVE is NOT
supported.

= The C code editor in ESD does not support the following features:

Code completion

Column mode

Line bookmarking

Error and Warning Marks

Structure Visualizer

Word Wrap

Expand and collapse blocks of code.
Highlighting of multiple selected text portions

O O O O O O O O

= If the project file path is too long (i.e., more than 512 bytes), ESD may have a
problem opening it. The typical error message is shown below:

“Unable to generate output files, check directory permission at:

C:\Users\xxxx.xxxx\Project\ESD\...... ”
Where
“C:\Users\xxxx.xxxx\Project\ESD\...... ~ refers to the project folder.

= Logic node editor background goes white after system hibernates.

= In some unusual cases, users may encounter a dialog box (shown below) which will
not affect the functionality. In this case, just ignore the dialog box by closing it.
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[ 1| EmulatorProcess.exe has stopped working

Wirdows can check online for 2 solution to the problem,

# Check online for a solution and close the program
% Close the program
# Debug the program

w . View problem details

= In few cases, users may need to click [Recompile] at the toolbar to update the
frozen simulation result.

= The Gameduino 3X dazzler platform does not currently support game controllers,
which means that users are unable to interact with ESD projects. Additionally, the
use of an SD card is necessary.

= Extended font is not supported in FT81X chips, but no error report will be generated
if choose it in ESD

=  When utilizing the ESD Circular Gradient Slider, certain scenarios may cause lines
to appear on the Screen Layout Editor (Emulator), as depicted in Figure 1. However,
no lines are ever displayed on the hardware side, as illustrated in Figure 2.

Figure 1 Screen Layout Editor

Figure 2 Hardware IDM2040-7A
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Terms & Abbreviations

Terms/Abbreviations Description

Actor

DLL

ESD
EAB
EVE Emulator
HAL

IDE
Layout type widget

Logic Node

Logic Node Editor
Page

Simulation
Widget

One type of logic node which is regularly updated but without visual
appearance

Dynamic Link Library is a collection of small programs, any of which
can be called when needed by a larger program that is running in
the computer

EVE Screen Designer
EVE Asset Builder
Bridgetek behaviour-modelling software for EVE Series chip

Hardware Abstraction Layer is a software subsystem providing
hardware abstraction.

Integrated Development Environment

One type of widget which has no visual appearance rendered by
EVE, but manages the associated widget

The node expressing certain logic. (Also referred to simply as “node”
in this document)

The place where you create logic by connecting the logic node

One single screen in design

Preview the project or page by running the generated C code on PC
One type of logic node which has visual appearance rendered by EVE

Open-Source Software

Qt: https://doc.qgt.io/gt-6/licensing.html under LGPL.

TinyCC: http://bellard.org/tcc/ and http://repo.or.cz/tinycc.git under LGPL.

Errorlist module: https://github.com/kaetemi/errorlist under MIT license
QScintilla: part of PyQt under PyQt commercial license
https://riverbankcomputing.com/commercial/license-faq

Icons Copyright

Some of the icons are from:
http://p.yusukekamiyamane.com/

They are used in compliance with the Creative Commons Attribution 3.0 License.
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C. Setup & Installation

System Requirements

To install ESD application, ensure that your system meets the requirements recommended

v' Ideally Windows 10; alternatively, Windows 8 or 7 with the latest windows updates
v" 1.6GHz or faster processor

v 1GB of RAM (1.5GB if running on a virtual machine)

v" Multi-Core CPU is highly recommended

v' At least 512MB hard disk space

v' Display resolution 1080x800 pixels or higher

v

“Write” permission to the installation folder

Hardware Requirements

The exported C source code from ESD is targeted at EVE based platform, which typically
consists of an Eve module and a host (MCU or PC based module).

The supported platforms are listed as below:

[Build Target]:

[Eve Platform] [Host Platform]

GD3X Dazzler Emulator

B Fra222
MMZ040EY

=] MPSSE

IDM2040-TA (BTE1T)

IDM2040-434 (ETEE3)

MESTTEV
VMETDC

VMEB1EC
STM32F4

MES17EV MTF 10 inch
MES17EV RiTFT 7 inch

MEZTRA-HVISR
MEST2A-WH30R

ME2T3A-WHS0C

Gameluino 3X Dazzler for Pico

[DM2040-TA

[DM2040-43A

Product Page 10
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Platform Name
(Build Target)
ME810A-HV35R

Compatible EVE Module
ME810A-HV35R%(320X480)

Compatible MCU
Module Name

Compatible PC
based Module

MM9OOEV!
MES812A-WH50R ME812A-WH50R® (800x480) MM2040E\V?2 N.A.
ME812AU-WH50R® (800x480) FT4222H8
ME812AU-WH50R N.A. (libFT4222.dll)
} _ 6 MMOOOEV!
ME813A-WH50C ME813A-WH50C® (800x480) MM2040EV? NLA.

} ) . FT4222H8
ME813AU-WH50C | ME813AU-WH50CS (800x480) N.A. (libFT4222.dll)
VM810C50A VM810C50A° (800x480) N.A MPSSE’

o (libMPSSE.dll)
. MPSSE’

VM816C50A VM816C* (800x480) N.A. (libMPSSE.dll)
a FT4222H8

VM816CU50A VM816CU* (800x480) N.A. (libFT4222.dll)

: s FT4222H8
ME817EV-WH70C | ME817EV5 (1024X600) MMOOOEV! (libFT4222.dll)

MM2040EV? FT4222H8

- 5
ME817EV-WH10C | ME817EV5 (1280X800) (libFT4222.dll)
Gameduino 3X Gameduino 3X Dazzler (HDMI D3 N.A.
Dazzler for Pico output 1280x720) Raspberry Pi Pico
IDM2040-7A IDM2040-7A° (800x480) Raspberry Pi Pico3 N.A.
IDM2040-43A IDM2040-43A (480x272) Raspberry Pi Pico3 N.A.
STM32F4 ME817EV5 (800X480) STM32 N.A.

1. MM900OEV development modules:
a. MM900EVXA - End of Life
b. MM900EVxB - https://brtchip.com/product/mm900evib/
c. MM90O0EV-Lite - https://brtchip.com/product/mm900ev-lite/
2. MM2040EV is a Raspberry Pi Pico adaptor board:
https://brtchip.com/product/mm2040ev/
3. Raspberry Pi Pico is from: https://www.raspberrypi.com/products/raspberry-pi-pico
4, VM816C is the EVE 3 development module: https://brtchip.com/wp-

content/uploads/Support/Documentation/Datasheets/ICs/EVE/DS VM816C.pdf

5. ME8S817EV is the EVE 4 development module: https://brtchip.com/product-

category/products/modules/eve4/

6. The EVE 2 development modules: check https://brtchip.com/product-

category/products/modules/eve2/ for details

7. MPSSE stands for “Multi-Protocol synchronous serial engine”. The following
Bridgetek or FTDI devices support it:

a. VA800A-SPI board
b. C232HM-EDHSL-0(5V) cable
c. C232HM-DDHSL-0(3.3V) cable

8. FT4222 refers to the bridge chip which converts from USB Hi-Speed transportation
to Multi-Channel Serial SPI protocol. See: https://ftdichip.com/products/ft4222h/
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9. IDM2040 is an embedded application platform from Bridgetek which consists of:

a. RP 2040 as MCU: https://datasheets.raspberrypi.org/rp2040/rp2040-

datasheet.pdf
b. BT817 as GPU: BT817/8 Advanced Embedded Video Engine (brtchip.com)

10. Gameduino 3X Dazzler is an open-source project originally for Arduino:
https://www.crowdsupply.com/excamera/gameduino-3x-dazzler
ESD supports one variety — Gameduino 3X Dazzler for Pico, which consists of:

e Raspberry Pi Pico as MCU module
e BT815 as GPU

You can get more details from:
https://excamera.com/sphinx/store.html#gameduino-3x-dazzler-for-pico-39

To ensure proper functioning of the hardware platform (FT90X modules or

& Raspberry Pi Pico), users need to make sure that an SD card is inserted into the
SD slot. This is because ESD is programmed to identify the presence of an SD
card, and if it fails to do so, the application may not work correctly.

Dependencies / Pre-Requisites

e Visual C++ Redistributable for Visual Studio 2015

If the PC does not have Microsoft Visual Studio 2015 installed, Visual C++
Redistributable is required. Users can download this from:

https://www.microsoft.com/en-sg/download/details.aspx?id=48145

¢ Windows 10 Universe C Runtime

ESD has run-time dependency on Windows 10 Universe C Runtime (CRT). You may
download it from https://www.microsoft.com/en-us/download/details.aspx?id=48234
and install on your PC should the following problem be encountered:

ScreenDesigner.exe - System Error ﬂ
& The program can't start because api-ms-wan-crt-runtime-11-1-0.dll is
migsing from your computer, Try reinstalling the program to fix this
problem.
| o

Figure 3 - Screen Designer - System Error

e FT9XX Tool Chain Version 2.6.0 or later

To compile and build projects, the FT9XX Tool Chain 2.6.0 or later version must be
installed on the PC. It is downloadable from https://brtchip.com/ftOxx-toolchain/ .

Please ensure that the Tool Chain executable path is defined by the system PATH
environment variable.
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Users are advised to check the known issues and limitations (of FT9XX Toolchain) while
building the ESD project with FT9XX Toolchain. The respective FT9XX Toolchain
package version release note contains the list of known issues and limitations.

For ESD, we recommend users to install FT9XX Tool Chain version 2.6.0 or later version
for the best results.

¢ Raspberry Pi Pico Tool Chain

To compile and build Pico projects, several tool chains must be installed on the PC.
They are: Pico-SDK, python 3.8, GNU Embedded Toolchain for Arm and Cmake. They
can be downloaded/cloned from the following:

=  Pico-SDK - https://github.com/raspberrypi/pico-sdk

= Python 3.8 - https://www.python.org/downloads/

= GNU Embedded Toolchain - https://developer.arm.com/downloads/-/gnu-rm

= CMake - https://cmake.org/download/

e STM32Cube Tool Chain

To compile and build STM32 projects, you need to install several toolchains on your
PC. These include STM32CubeIlDE and STM32CubeProgrammer, which can be
downloaded from the following links:

= STM32CubelDE:https://www.st.com/en/development-
tools/stm32cubeide.html

=  STM32CubeProgrammer:https://www.st.com/en/development-
tools/stm32cubeprog.html

ESD will check SVl File Edit Build Tools View Help
environment variables to find B R = Generate Class ID Ctrl+G
thes_e tool Cha”_'lsl and it _also - = Clean Unused Generated Files Ctrl+Shift+P
provides a user dialog to configure [EEss s e ? o
the tool chain path under Tools oM Configure cross-compilation Environment Ctrl+Shift+C
menu:
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Browse

Browse

Browsze

Browse

Browse
Device:

Browse

Browse

Cancel

Installing ESD Package

The following steps will guide you through the ESD Setup/Installation process.

i. Download the package from https://brtchip.com/esd/.

ii.  When prompted with a download dialog | sctve- Ve sereen desionr - *

box. Click [Save].

Welcome to the EVE Screen
Designer Setup Wizard

iii. Navigate to the folder under which the
package files are downloaded.

This will install EVE Screen Designer version 4. 13 RC1 on your
computer.

Itis recommended that you close all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

iv. Extract the zip file contents. Double
click on the executable file - EVE
Screen Designer.exe

The EVE Screen Designer Setup Wizard
is displayed along with a Welcome

message. Click [Next]. Cance
Product Page 14
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V. End User information window is
displayed. Click [Next].

Vi. Select the “Destination
Folder” for installing the files.
Accept the default folder or
click Browse to select a
different destination folder. To
confirm the destination folder
and continue, click [Next].

Vil. In the Select Additional
Tasks window, check “Create
a desktop / Create Quick
Launch shortcut” boxes, to
have the ESD icon and Quick
Launch shortcut displayed on

the desktop if required.
Click [Next] to prepare for the
installation.

The initial setup is completed,
and the application is ready to
be installed.

155 Setup - EVE Screen Designer = X

Information
Please read the following impertant information before continuing.

When you are ready to continue with Setup, didk Next.

:.‘E.V.E Sci'een Désigner 4, i3 pre‘R‘éIéase‘ ~

Featues:
WYSIWYG IDE
Logic node based Visual Programming method for screen logic creation
AMSI C Code generation for completed project
Live preview the designed project
Higher level widget and widget communication
Interactive widget
Extensible Widget Library
Tool Chain integration
Comprehensive example projects.

< Back

Cancel

ﬂ':,_'j] Setup - EVE Screen Designer - *

Select Destination Location
Where should EVE Screen Designer be installed?

Setup will install EVE Screen Designer into the following folder,

To continue, dick Mext. If you would ke to select a different folder, dick Browse.

‘lblic\,Documents\,E\fE Screen Designer| Browse...

At least 327.6 MB of free disk space is required.

< Back

Cancel

ﬁj Setup - EVE Screen Designer - x

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing EVE Screen
Designer, then dick Mext.

Additional shortcuts:
Create & desktop shortcut
Create a Quick Launch shortout

< Back

Cancel
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viii. Click [Install] to start the installation.

ﬂ% Setup - EVE Screen Designer

Ready to Install
Setup is now ready to begin installing EVE Screen Designer on your computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
Ci\Users\Public\Documents\EVE Screen Designer

Additional tasks:
Additional shortouts:
Create a desktop shertout
Create a Quick Launch shartout

= Back ] Install ] Cancel

The progress bar indicates that the installation is in progress.

iX.
fg’ﬂ Setup - EVE Screen Designer l = | = &J
Installing
Please wait while Setup installs EVE Screen Designer on your computer,
Extracting files. .,
C:\Users'Public\Documents\EVE Screen Designer \ObjectWidgets. dl
(4]
X. In the Information page, click [Next] to proceed ahead.
ﬁ'r! Setup - EVE Screen Designer —
Information
Please read the following important information before continuing.
When you are ready to continue with Setup, dick Next.
Eredis:
Product Page 16
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Xi. Upon successful installation, click [Finish].

b

ﬂ Setup - EVE Screen Designer

L= . |

Completing the EVE Screen
Designer Setup Wizard

Setup has finished installing EVE Screen Designer on your

computer. The application may be launched by selecting the

installed shorteuts.

Click Finish to exit Setup.

Finish

Installation Folder

The following table provides a list of folders that can be found under the installation path:

Folder Name
Examples
Imageformats

Styles
Libraries

Log
Manual

Platforms
Settings

Templates
TinyCC

Tools

Description

The example projects created by ESD
Qt run-time DLLs for image format
supporting

Qt run-time DLLs for UI styles
Widget library, application framework
and Hardware abstraction layer
Stores the runtime logs for debug
purpose

Contains this document

Qt platform specific run-time DLLs
Configuration files for third-party
utilities and tool chains as well as ESD
settings.

The files are in XML format.

The template files used by ESD
TinyCC run-time used for ESD
simulation purpose.

The utilities used in ESD for bitmap
and font data generation purpose
Table 1 - Installation Folder

Permission
Read/Write
Read-Only

Read-Only
Read-Only

Read/Write

Read-Only
Read-Only

Read-Only.
Reserved for advanced
users to change.

Read-Only
Read-Only

Read-Only
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D. Working with ESD

Major features

Support full BT81X features

Users can refer to EVChargePoint examples in the path <ESD Folder>/Examples/
Advanced/EVChargePoint. Opening it may take more than 5 minutes because of ASTC,
bitmap and font conversion. This example contains all of the new BT81X features. Here
are the details:

1. Apply ASTC Bitmap Format for images and fonts.

Value

il @@

B.ttf
Value

Resou

Font

EXTENDED_ASTC

24
Figure 4 - ASTC applied for images and fonts

2. Resources are stored and loaded from flash.

Value

Value

Resources/BtnCharge.png
Bitmap

COMPRESSED.|
Falze
v True

Figure 5 - Load resources from flash
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3. Use Unicode font with ASTC format and predefined character set

source File Proxy
File Mame sc/MotoSansCIKscRegularl.otf
Name
Category

egularl6.tf Format EXTENDED_ASTC

FERRRHiE]: Fit

Figure 6 - Use Unicode font with pre-defined character set

...
( : )— 30% I
- - Y \\ 76 250
\\ AR TR
2L 5
/!'

— = -

Figure 7 - Chinese font used in application

Support for ASTC bitmap format

ESD provides the option to convert images to the ASTC bitmap format, resulting in
significant storage space savings without compromising image quality.

Product Page 19
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LETTEDS65
PALETTED4444

PALETTED8
DXTL
IPEG

Figure 8 - ASTC Format

Support DXT1 bitmap format

DXT1 (also known as Block Compression 1 or BC1) is the smallest variation of S3TC,
storing 16 input pixels in 64 bits of output, consisting of two 16-bit RGB 5:6:5 color
values(c0,cl), and a 4x4 two-bit lookup table. ESD supports the following 3 varieties of
DXT1 format bitmap.

o DXT1: the 4x4 two-bit look up table is expressed in L1 format, while c0,c1 is
expressed in RGB565 format.

o DXT1L2: the 4x4 two-bit look up table is expressed in L2 format. while c0,c1
is expressed in RGB565 format.

o DXT1PALETTED: the 4x4 two-bit look up table is expressed in L2 format. while
(c0,cl) is expressed in PALETTED565 format.
By replacing the RGB565 layers with PALETTED565 layers, the size is further
reduced to 2 bytes per block total for the color layers, which results in a 3 bits
per pixel plus the color palette of up to 512 bytes.

Just as with other bitmap format, once the image is added into project, users can select
the "Format” property of input image and set it to the DXT1 related format. The example
project "BitmapFormats” shows the effect of DXT1 format bitmap, by comparing with other
bitmap formats which Eve supported.
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Library.

Properti
Property
ce File Proxy)
File Name
Name
Cotegery
Format

npressed

PALETTED4444
PALETTEDS
DXT1

DXTIL2
DXTIPALETTED

IPRESSED.f

RAM G P Flash: LR

Appimain

DXT1

Figure 9 - DXT1 format bitmap in BitmapFormats example project

Output Format for DXT1:

When the DXT1 format is selected in ESD, itis then converted to two file formats: *_b0.raw
and *_c0.raw, or alternatively, *_b0.bin and *_b0.bin (if the compressed flag is selected).
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MewProject3e » Build » [DM2040-74 » Data v 0 Search Dlata
I Marne Date modified Type Size
|| MochiRiceCakeDXT1_bO.kin 1/2/2024 6:20 pm BIM File 12 KB
:| MuaochiRiceCakeDxT1_c0.bin 1/2/2024 6:20 pm BIM File 12 KB

] MochiRiceCakeDXT1_b0.bin.esdm 1/24 0 pm ESDM File VR
[ ] MachiRiceCakeDXT1_cD.bin.esdm 1/2/2024 6:20 pm ESDM File 1 KB

Users must download the converted bitmap resources, either *_b0.raw and *_c0O.raw or
*_b0.bin and *_b0.bin, into the root directory of an SD card. Subsequently, insert the SD
card into the hardware module. There is no requirement to download the .esdm file format
onto the SD card unless dynamic bitmap loading is used. For the dynamic bitmap loading
feature, .esdm files must be copied to the root directory of the SD card.

Output Format for DXT1L2:
The DXT1L2 output format closely resembles DXT1. When ESD is converted, two file

formats are produced: *_b0.raw and *_c0.raw, or alternatively, *_b0.bin and *_b0.bin (if
the compressed flag is selected).

« NewProject3s » Build » IDM2040-TA > Data vl Search Data
i Marme Date modified Type . Size
le [#] MochiRiceCakeDXTIL2_cO RAW File 19 KB
E] MechiRiceCakeDXT1L2_b0 RAW File 19 KE
_I MuochiRiceCakeDXTILZ_cOraw.esdm ESDM File | KB
J MechiRiceCakeDXT1LZ_b0.raw.esdm ESDM File 1 KB

To use the converted bitmap resources, users need to transfer either *_b0.raw and
*_c0.raw or *_b0.bin and *_b0.bin files to the root directory of an SD card. It's important
to note that there is no need to download the .esdm file format onto the SD card unless
dynamic bitmap loading is used.

Output Format for DXT1PALETTED:
If the DXT1PALETTED format is chosen in ESD, it undergoes conversion into three file

formats: *_b0.raw, *_index.raw, and *_lut.raw. Alternatively, when the compressed flag
is selected, the conversion results in *_b0.bin, *_index.bin, and *_lut.raw.

MewProject8 » Build » VMB16C50A » Data v & Search Data el
FOR™ Name Date Type Size Tags

_] MachiRiceCakeDXTIPALETTED_b0.bin BIM File 16 KB

J MechiRiceCakeDXTIPALETTED index.bin BIM File GKE

_: MochiRiceCakeDXTIPALETTED b0.bin.esdm ESDM File 1 KB

_] MechiRiceCakeDXTIPALETTED index.bin.esdm ESDM File 1 KB

[5] MochiRiceCakeDXT1PALETTED lut RAW File | KB

To utilize the converted bitmap resources, users should download either *_bO0.raw,
*_index.raw, and *_lut.raw or *_b0.bin, *_index.bin, and *_lut.raw files into the root
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directory of an SD card. Following this, insert the SD card into the hardware module. It's
important to note that there is no need to download the .esdm file format onto the SD
card unless dynamic bitmap loading is used. For the dynamic bitmap loading feature,
.esdm files must be copied to the root directory of the SD card.

Support extended font format

Unicode font file can be added to a project by clicking File -> Add from the menu bar and
in the Property window, input font size and character set as desired.

Properties
Property Value
urce File Pr
Resources/KaonGel ttf

Name Font

Format EXTENDED_ASTC

Font Size

Figure 10 - Font size and Character set

Once the font resource is ready, add a widget, such as ESD Label, ESD Button to project.
In Property window, select appropriate “Font Resource”.

Value

ESD Label
Static
0.00

v True
25

80

Width 1

Height
Auto ESD_AUTORESIZE_HEIGHT
Ft_Esd_Theme GetCurrent

lpha
Font
Font Resource

Figure 11 - Select Unicode Font Resource
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BiELSTETNET
PEIKXOITIVET

Cood morning

Figure 12 - Unicode font applied for Label and Button

ASTC Encoder

Since ESD 4.12, the ASTC encoder is upgraded to version 2.0. This is a new version of
ASTC encoder, which is responsible for the image conversion process to ASTC format. It
is from ARM and claims 30% faster performance than ASTC encoder 1.0.

Video Converter

ESD enables users to add video format into project and converts it to Eve specific format
by employing ffmpeg.

It eases the procedure to add the video playback functionality in ESD project. In ESD
examples project playvideo is added to play an mp4 video and avi video. After that, the

videos are converted to mjpeq format and played.

Support Animation

ESD enables users to add EVE specific animation file (.anim) into project. The key features
are:

o auto generation of c file and widget files
o thumbnail
o start and stop signals
User can convert .gif file to .anim file with EAB tool.
The steps to add an animation is as below:

1. Convert .gif to .anim with EAB tool

2. Add the .anim file into a ESD project

3. Drag the animation widget from user widget (automatically generated) to the page
which includes the animation

4. Create customized start and end signal, and connect them to the corresponding
slots on animation widget
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Figure 13 - Create animation in project

The example project PlayAnimation showcases how to play and stop an animation. The
screencast video “playAnimationtutorial.gif” under the same folder records the procedure
to design the example project.

Generate Flash file and write Flash file to device

Resources can be loaded from EVE-connected flash or RAM_G. ESD can generate Flash

file for BT81X projects, then uploads the flash file to the device by pressing the & [Build
and Upload to Hardware] button.

Properties

Property Value

rce File Pro
F me Resources/Lenna_120.jpg
Mame Bitrnap
Category
Format COMPRESSED_RGEA_ASTC !
SE v True
v True

Figure 14 - Mark resource as storage in Flash

g

Run Executable

Upload Flash and Run Executable

Figure 15 - Upload Flash file to device

Product Page 25
Document Feedback Copyright © Bridgetek Pte Ltd



\/

\/
.0 l
‘0

*

B 'd k BRT_AN_029 EVE Screen Designer 4.19 User Guide
rl QEte Version 1.8

* BRIDGING TECHNOLOGY

Document Reference No.: BRT_000218 Clearance No.: BRT#159

LittleFS File System with EVE connect flash memory

The LittleFS is a fail-safe file system designed for embedded systems, specifically for
microcontrollers that use external flash storage. BT815 and above devices support flash.
The AssetBrowser example project demonstrates the utilization of the LittleFS file system
in ESD. Kindly review the following steps outlining how to use LittleFS within the project.

1) In the ESD Project properties, it's essential to ensure that the LittleFS Flash file
system is selected as "True"

~ Definitions
0]
[l
121

131
4]
[51

Figure 16 - LittleFS enable option in Project

2) Within the Resource Image properties, it is imperative to choose the Resource type
as "ESD_RESOURCE_FLASH".

Properties

Value

COMPRESSED_RGBA, ...
False
ESD_RESOURCE_FLA ~

Figure 17 — Selected the ESD_RESOURCE_FLASH

3) Initially, call the Esd_LittleFS_Mount() API function from the C source code within
the project. This API verifies if LittleFS is enabled. Upon verification, it proceeds to
invoke the Esd_ LittleFS_Configure() and Ifs_mount() functions.

26
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Figure 19 - ESD_LittleFS.c file in ESD_Core
4) Open the directory using Ifs_dir_open(Ifs, &dir, "/") API function, and read each

entry in the directory with while loop using Ifs_dir_read(Ifs, &dir, &info) API
Function and get the output File Name and File Size.

ead each entry in the directory
{1fs dir re 1fs, &dir, &info)} > 0

e and size

1fs dir close(lfs, &dir);
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5) Generate rows consecutively using the “addWidget(context, info.name, info.size)”
function, including the image file name, file size, and Preview push button.
Additionally, within this function's verification process, rows won't generate if the
file name contains ".esdm". However, if the file name doesn't contain ".esdm", the
rows will be created as planned. For further details about ".esdm", please refer to
page 55.

ESD Asset Browser Fefresh

Catgirl.astc 256.00 KiB
Gircle.astc 256.00 KiB
Fireworks.astc

Seascape.astc

Figure 20 — Show all the images name in the project AssetBrowser
6) After «clicking the Preview button, trigger the execution of the
loadResource(context) function. Inside this function, set the current image file
name to bitmapinfo. Proceed to retrieve the flash address using

Esd_BitmapInfo_LoadFlashAddress(&context->BitmapInfo) and then assign
bitmapinfo with the flash address into the Image Viewer.

loadResource (Usr_AssetPreview *context)

print
// Load o

Circle.astc:

Figure 21 — Show preview image in the project AssetBrowser
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Restructured EVE HAL Library

EVE HAL Library contains C source files, and a sub-folder “Hdr” that comprises of the C
header files. The EVE HAL Library comprises the source code for the EVE HAL platform,
the header files for the EVE HAL platform, and coprocessor commands.

Memory management

Some of the widgets in ESD will use heap memory, in other word, malloc and free will be
used. In the embedded world, it is not recommended due to multiple drawbacks of using
heap. However, it is not easy for ESD to fully use static memory because it is an UI design
tool. So, a memory pool management module is developed in ESD4.16 onward, with this
implementation, user can restrict the heap memory usage into a controlled range as
below:

¥ EVChargePoint.esd 2
~ Definitions

[01

(43}

Simulation ~

Figure 22 - Config the memory

Figure 22 shows that 2 variables pre-allocated memory and Memory limit are defined in
the properties of the root project to configure memory allocation. Pre-allocated memory
is the estimated memory usage of the project, and memory limit is the max value can be
assigned to the project, if the pre-allocated memory is not enough due to some reasons,
ESD will try to extend the memory up to the memory limit. The minimum values of pre-
allocated and memory limit are 0 because not all the widgets use heap memory. The
default values are 72456 for Memory Limit and 36228 for Pre-allocated Memory, and user
should modify them according to the real memory usage of their projects.

UI enhancements

The following User Interface related enhancements have been added to ESD -

Filter for Library Browser and Project Browser window

More comprehensive toolbar buttons for platform description
New menu to clean up unused/generated files in project
Simplify the process of adding new resources into project
Added context menu for document tab

Impacts of ESD 4.X updated features

Since the new/updated features of ESD 4.X may cause API changes, existing ESD 3.0
projects are not fully compatible with ESD. Although ESD 4.X has the utility inside to detect
and migrate opening ESD 3.0 project, it may still not work as expected.

e ESD Layouts: A new category of widgets "ESD Layout” are introduced into the Library
Browser, which enables the layout feature.
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e ESD Widgets: A new set of widgets are introduced into "ESD Widgets” category in the
library. These set of widgets are to be used in constructing the pages. The nodes under
the “ESD Render Functions” are not supposed to construct page as it has no widget
interface and the layout widget is unable to manage them.

Migrating from ESD 3.0 to ESD 4.X project

When ESD 4.X opens an existing ESD 3.0 project, it will prompt users to migrate to the
latest version. If user chooses not to migrate, ESD 4.X will not open ESD 3.0 project.

MIGRATION NOTES

1. Please back up your project if you are not sure about
the migration. The migration process will overwrite
the project and it cannot be reversed.

2. The migrated project file will be renamed from
“* . esd3"” to "*.esd”. = Conpactions

‘& MNodes

3. The target module of the opened project will be
redirected to two built-in platforms after migration.
So, if the target module is in 320 x 480 resolutions,
users may select the platform “ME810A HV35R” = i
from “Build Target” combo box from the toolbar and R Nodes

make a platform switch. > il Widgets
@ Switch Page
& Main Page
Bl MainPage.page

VMB 16CUIS0A = 1 yMB16C - | B wvea {goox = | E1FT4222 » | [Elwzsgizs -

Build Target

In some cases, if an existing ESD 3.0 project cannot be migrated to ESD 4.X, then users
are required to migrate manually.

e The variable "Parent” of logic is renamed to "Owner” in ESD 4.X.

o X, Y, Width, Height properties in widgets is now accessible through the widget variable.

o Instead of pointer, struct "Ft_Esd BitmapCell” shall be used by value in ESD 4.X.

e In order to restore the default behaviour of application logic "App.main”, users may
need to manually move the existing pages into layout widget "Switch Page” in the
Project Browser.
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Setting Platform Specific Properties

ESD users are able to create one project supporting multiple platforms with various screen
size. Therefore, on different platforms, the same widget may have a different property
value. For instance, for a platform with screen size 480 x 320, the button size may shrink
to a smaller size from the original value for a platform with screen size 800 x 480.

Users can make a property value specific to the current target through the context menu
of the property browser. This can be done by right clicking the selected property of the
current widget. This is illustrated in the picture given below -

Value

ESD3 Label
Staf

Make value specific to current target

Reset to default value
Height
Auto Resize

OPT_ALIGN_LEFT
OPT_ALIGN_TOP

Figure 23 - Making Value Specific to Current Target

User can remove value specific to current target through context menu in property browser
by right clicking the selected property of current widget. This is illustrated in the picture
given below -

Properties
Property Value
(ESD Push Button)
Name ESD Push Button 4
Allocation Static
Depth Sort 400
Active v True
X 196
" Remove target specific value 439

Width Resi default value 120

Height 36
Theme Ft_Esd_Theme GetCurrent

Fant 27

Text Bottom Right
Primary ¥ True

Figure 24 - Removing Target Specific Value

Users can refer to the “ScreenResolution” project under the “Installation/Example” folder.

Migrating existing projects to new platform

All the existing projects may have been developed using a specific platform. Users can
choose to migrate their projects to a different platform by selecting the appropriate “Build
Target” combo box. If the desired target is not available in the “Build Target” Combo box,
then the user can configure the individual specifications (“Eve Platform”, “Display
Resolution” and “Host Platform™) of the target by selecting the appropriate combo boxes.
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Advanced User Settings

Advanced users are allowed to configure the ESD settings to better assist them in their
GUI application development with EVE products. The Advanced User Settings allow the
user to turn on/off specific features and functions in the ESD. This section shall provide a
brief explanation on the usage and effect on the ESD. As it involves modifying the
application configuration file, it should only be carried out by someone with adequate
knowledge. It is recommended to leave any advanced settings at their default settings.

Application Settings

The “Main.config” file can be found in the “Settings” folder under the installation path. This
file contains application wide settings which may affect the interface and behaviour of the
ESD. Users are allowed to modify to suit their application needs. After the modification
has been done, a restart on the application is required for it to take effect.

Below is the list of settings that can be found in the file.

= PortableSettings - Enabling/Disabling loading cenfigue cres-compittion Environment a
of Host Device Environment settings from the
from Screen Designer config upon startup. The
loaded settings will be reflected in “Config Host
Device”.

= SimplifiedExport - Enabling/disabling of the [Naie = S as: Tk S . e T
simplified export menu actions. An “Export” Export as Pico Project Ctrls Shift-E
option will be displayed under the menu bar if
it is disabled.

. ” . . . New Project Ctrl+N
The “Export” option will be shown under file

PR Ope Ctrl+ 0
menu if it is enabled. Open Project Ctrl+

Save Project As Ctrl+Alt+5
Ctrl+ Shift+W

Clean and Close Project Ctrl+P

Export as Pico Project Ctrl+Shift+E

= Hiddentypes - Hide types from library and menu interface. The listed parameters under
the “HiddenTypes” will be hidden. o

o _GroupHidden - A new set of commands will be
made available to user when it is removed from the
hidden state. These controls are mainly to be used
by advanced users.

v [ ESD Layouts
| der Functions
»
b
b

o _WidgetDocument - Allows the user to create new
customised widget.
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o _LlogicIncludeHeader - This allows the user

to use “include header” logic node under the ESD Reinder Fancfieies
library which helps to add a header file into B ESD Theme
project. I ESD Utilities

| ESD Widgets
Logic Flow
T Condition
T Binary Condition

ﬁ Include Header

o _logicWatcher — This allows the user to
access “Watch Variables” logic node ]
which helps to watch multiple variables Switch Value

for change. Set Variable
Watch Vanables

1 Logic Interface

o _SourceFile - This allows the user to add new empty .c file to the project.

= Enablelnspector - Enabling of Inspector [fESese
window which is useful for debugging.

e ol o B b o — S

Live:

Inspector Error List
= ShowBitmapHandleUsage - Displaying of bitmap handle usage in status bar.

" Keywords - List of keyWordS to be #¢ File object name conflicts with a reserved keyword X
avoided when naming ESD file object.
An error display message box will be
shown if there is a conflict with the
reserved keyword.

x [while.c] has a reserved keyword as its name. Please rename the filename.

oK
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Troubleshooting

If you build the project with the incorrect host platform, errors may be displayed. Always
ensure to choose the correct EVE host platform. Refer to additional details for further

information. See the table

ESD Actor Animators

As depicted in the figure above, an error commonly arises when the Eve platform VM816C
does not correspond to the host platform MM900x. Ensure that you choose the correct
host platform, namely FT4222.

As depicted in the figure above, if ESD encounter an error during the creation of a new
project using the build targets VM816C50A or VM816CU50A due to an incorrect EVE
platform. Please make sure to select the correct EVE platform, which is VM816C.

Product Page 34
Document Feedback Copyright © Bridgetek Pte Ltd



Bridgetek BRT_AN_029 EVE Screen Designer 4.19 User Guide
BRIDGING TECHNOLOGY Version 1.8

Document Reference No.: BRT_000218 Clearance No.: BRT#159

There is a welcome dialog which will be popped up when ESD is started.

A Welcome 4

- ST wre alLaginPattem,esd

Users/wu.jian/Dacuments/Documents/ESD-Project/NewProject/test16/test]6.esd

Users/wu jian/Dacuments/GitHub/ESD30Pratotype/Dist mples/Intermediate/CircularGradientWidget/CircularGradientWidget.esd

mples/Advanced/WashingMachine/WashingMachine.esd

Users/wu.jian/Dacuments/GitHub/ESD30Pratatype/ /Examples/Intermediate/Signal Switch/Signal Switch.esd

Users/wu.jian/Documents/Documents/ESD-Project/NewProject/test15/test]5. esd

Users/wu.jian/Dacuments/GitHub/ESD30P ratatype/Distrib/Examples/Basic/BinaryCandition/BinaryCandition.esd
n/Dacuments/GitHub/ESD30Pratotype/Distrib/Examples/Basic/AutaSwitchLayout/AutaSwitchLayout.csd

sers/wu,jian/Decuments/GitHub/ESD30Pratatype/Distrib/Examples/Advanced/WeatherStation/WeatherStation.esd

Figure 25 - ESD welcome dialog
A: Create a new project
B: Open an example project
C: Open a project in the file system
D: Recent project, double click to open

Create a new project:

e New Praject X
i

[] MEST0A-HV3SR
] ME812A-WHSO0R
] MEB13A-WHS0C
[ vmB16CUS0A
[ vme16cson
] MEBI7EV
GameDuino 3X Dazzler for Pica

| IDm2040

MES10A HY35R

ME810A-HV35R (FTB10)

EVi n
ILI9488 (320x480) Resistive

EVA

MM3I00EV2A

: [ FT_Eve_Hol (Required)
Esd_ Core (Required)
| FT_Esd_Framewark (Required)
[ FT_EsdWidgets {Required)
[ Esd WebStyte Widgets (Optionat)

it

Figure 26 - ESD new project dialog
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The dialog allows user to create a new project with predefined build target listed in the
picture, or configure a new build target (choose platform, display resolution, host platform,
flash chip and touch IC) with New Target button.

Example projects:

He Examples ? ®

Basic | Intermediste | Advanced ‘
FSD Actor Animators.

ESD

ActorAnimatars AnimatedLayout AutoSwitchLayout BasicMath

Resolution: 800x480 R, : 800480 Resolution: B00x480 Resolution: BOOx480
I 9 R E = 1
| e : o " ¢

Omm
Equal

o=

]

BasicWidget BinaryCandition EitmapFormats ClackTimer
Resalution: 800x480 Resalution; B00x480 Resalution: B00x480 Resalution: 800x480

ESD c rorn:

First Page

ColorMath ColarPicker ConditionalFlow DynamicSwitch
Resolution: BOOx4B0 Resalution: B00x480 Resolution: 800x480 Resolution: BOOx4B0

Figure 27 - ESD example prject dialog

A: Tab which represents 3 different categories of example projects, user can switch the
category by clicking it.

B: Thumbnail of the project, project name and default resolution

C: Search bar which enable user to select keyword, keyword will match project name and
project description. Dialog will update view and only show the matched projects when user
input a keyword

D: Project description

E: Open button, it will open the selected project.

F: Back button, show original welcome dialog if this button is clicked.
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User can choose to show welcome dialog again by below menu if it is closed:

File

Edit
New
B Add
| Save

Close

Build Tools Wiew Help

| Sawve All
Mew Project
Open Project

| Save Project As

Close Project

Clean and Close Project
Exportas MSVC Project

Show Welcame Dialag

MES1

Ctel+5
Ctrl +W B.D

D

120 160
1 1

Ctrl +Shift+5
Ctrl+N
Ctrl+0

Crl +Alt+5
Ctrl +Shift +W
Ctrl +P

Ctrl +Shift +E
Ctrl +Alt+W

Figure 28 - ESD show welcome dialog menu

AppScresn.page

FirstPage.page  *

00 240

28D
I
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The Graphical User Interface

ESD user interface has the following components:

Menu Bar
Toolbar
Project Explorer
Screen Layout Editor
Logic Node Editor
Library Browser
Error List/Inspector
Output window
Property Editor

0 Status Bar

HOONOOUANWNR

= e 11 AC3 [P Time: D 102020 0R3507) (BTOK bl o x|

LLLL
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The Menu bar displays the headings for each drop-down menu. According to the function,
the commands are grouped under each of these menu headings.

Menu bar File Edit Build Tools View Help

Menu item New » B Logic
A o
selected . Actar

Ctr+S B wWidget

Ctrl+W EE Page .
. ; Sub menu item
Menu items ' CtrteShiftsS B Theme

Mew Project Ctrl+N B Source Files

B Logic Source Files

en Project Ctrl+ 0
e Project As Ctrl+ Alt+5

Close Project Ctrl+Shift+W

Clean and Close Project Ctrl+P
Export as MSVC Project Ctrl+5hift+E
Show Welcome Dialog Ctrl+ Alt+W
1: Newfolder3.esd

2: Newfolder.esd

3: AutoSwitchLayout.esd

Exit Alt+F4

Figure 30 - Menu bar

The following table provides the list of Menu/Submenu and its description -

Menu Submenu Description
File New Logic
Actor
Widget
Page
Theme ' creates new file for the current project
Source
Files
Logic
Source
Files
Add To add existing file(s)/resource (such as bitmap, C source
file etc.) to the project
Save To save the current file
Close To close the current file
Save All To save all the files in the current project
New Project To open a new project
Open Project To open an existing project
Close Project To close a current project
Clean And To clean current project then close it
Close Project
Product Page 39
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Edit

Build

Tools

Export as
Eclipse
Project
Export as
MSVC
Project
Export as
Pico
Project
Show
Welcome
Dialog
1:<Project
Path>
Exit

Undo
Redo

Cut

Copy
Paste
Find
Replace
Build
Executable
Build and
Upload to
Hardware
Browse to
Executable
Generate
Class ID

Clean
Unused
Generated
Files
Configure
Cross-
compilation
Environment

To export as Eclipse project. This will only be shown when
supported platform is selected

To export as MSVC project. This will only be shown when
supported platform is selected

To export as Pico project. This will only be shown when
supported platform is selected

To show welcome dialog which include create new project,
show example projects, open project in file system and
open recent projects options.

To open recent projects, up to 10 projects

To close the ESD application

To reverse the action of a recently performed action
To revert the effects of the undo action

Cut the selected node(s) to clipboard

Copy the selected node(s) to clipboard

Paste the node(s) from clipboard

Find a specific text string in source editor

Replace a specific text string in source editor

To generate an executable file

To generate an executable file and upload to hardware

To navigate to the folder under which the executable file is
located

To generate a Class ID for user widget or layout. It is a
hash from the widget name and generally useful when
user prefers to write code in “C” language.

To clean the generated files which are not in use

To show the current tool chain path for the host device,
and user can change the paths according to their own
configuration.
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Configure cross-compilation Environment =]

ToolChain name Browse button
with hyperlink, e to let user
choose folder
open the
installer

Cancel the

current settings,
restore to

previous
Update all the settings before
settings show open this dialog
here to update
gsettings

View Project
Library
Properties To display or hide a component view. By default, all the
Inspector components are displayed.
Error List
Output
Help User Guide Opens the User Guide with respect to current version
Widget Opens the user guide which describes the in-built widgets
Introduction in ESD.
Guide
About Displays the version details
3rd Party Displays the copyright, disclaimer and license information

of the 314 party software
Table 2 - Menu & Description

The Toolbar provides easy access to common functions (in the form of icons) such as new
file, save file, undo, redo etc.

New Save Undo  Simulation Recompile
Add Save Redo Restart
All
Figure 31 - Toolbar 1
Platform Screen Flash chip Build Build and Upload
Target Size Type Executable to hardware

EVE Meodule type MCU Platform TouchIC Toolchain Programmer
type
Figure 32 - Toolbar 2
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The following table provides the list of toolbar functions and its description -

Toolbar Function
New

Add

Save
Save All
Undo
Redo
Simulation

Restart
Recompile

Platform Target
EVE Module Type
Screen Size
MCU Platform
Type

Flash Chip Type
Touch IC

Build Executable
Toolchain

Build and Upload
to Hardware
Programmer

119 - 16:26:57] [BIBXX Emulator Library v3.0.6)

MES13AU-WHS0C -

AppScreen.

Figure 33 - MCU Type is not applicable to selected platform

Description

To open new Logic/Actor/Widget/Page/Theme/Source Files/Logic Source
Files

To add existing resource (such as bitmap, C source file etc.) to the
project

To save the currently open file

To save all the files in the current project

To reverse the action of a recently performed action

To revert the effects of the undo action

A toggle button which starts or stops the simulation mode.
- This state indicates that the ESD 4.14 is in simulation mode.
Clicking this button stops the simulation.
b

- This state indicates that the ESD 4.14 is out of simulation mode.
Users can drag/drop widgets or edit them safely.
To automatically restart the EVE emulator. Clicking this button will force
the simulated screens to be re-drawn.

To recompile the whole project’s source code using ESD built-in TinyCC
compiler. It is @ mandatory procedure for simulation.

Select the hardware platform as source code building target

To select EVE module type

To set screen size

Select the building configuration when toolchain is invoked to build

To select flash chip for BT81x based series platform
To select capacitive touch controller type

Build the project files

Select toolchain to build

Upload Flash file to device and/or run executable file

Select executable mode
Table 3 - Toolbar & Description

Emulator

[ MEB 13AL-Wt = G WVGA (B00x ~

MMS00EVLA

App.main

MMIOOEVIE

MMIDOEW-Lite
MMIS0EW-Lite

The red exclamation mark in the image above means those MCU types are not applicable
to the currently selected platform.
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Touch IC configuration

FT811, BT815 & BT817 work with capacitive touch controllers. Currently, only the following
capacitive touch controllers are supported by EVE:

FocalTech: FT5xx6 / FT6xx6 series IC
Goodix: GT911/GT9271 series IC.

ESD users can configure the touch IC controller by using the touch IC configuration combo
box as shown below.

More information on the touch controllers can be found in AN_336 and BRT AN 090.

Disabled
EOHDMI 72 = | FoRaphe = [ I Focallech |} RP

Goodix

A5TCPagel.page Appmain ARGEPage.page 1 T Resistive

Figure 34 - CTP configuration

Project Explorer

The Project Explorer window organizes all the files used in the project in a tree view. It
also lists out all the resources used by each file. Project explorer allows users to navigate
each page of the project.

Figure 35 - Project Explorer window

In case of many items existing in a project, user can use filter textbox in order to get a
sort list of items. Text that matches the filter is highlighted. Regular expressions are
supported.
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Project
arcjpanel

* B

B FtEd
N Ft Esd

Figure 36 - Project Explorer Filter
Screen Layout Editor

The Screen Layout Editor displays the rendering output of EVE and allows users to edit C
source code. The page/widget/main files can be opened and edited in this editor.

MainPage.c * App.main

ESD

Figure 38 - Screen Layout Editor - MainPage.c (C Source Code)
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It shares one view port with the logic node editor. Users can adjust the size of the screen
layout editor by dragging the splitter handle.

Users can drag and drop the widgets from the library browser to form the layout when

simulation mode is "off”. For the other kinds of logic nodes, if the EVE rendering process
is not defined, screen layout editor does not allow them to be dropped in.

FirstPage.page App.main AppScreen.page

Close tab 160 180 200 22
] 1 1

I
Close other tabs

Close all tabs

Figure 39 - Context menu on Tab bar

Users can right click on tab bar to active a context menu. Those menu items are described
in table below.

Menu Description

Close tab Close the current tab

Close other tabs Close all tabs except the current tab
Close all tabs Close all tabs that were opened

Logic Node Editor

The Logic Note Editor allows users to layout logic nodes and to establish connections to
create logic maps. Users can drag and drop a logic node from the Library Browser
component to the Logic Note Editor in order to create connections.

Fixxed Position Set Variable ESD Label 4
Pointer ] e ] Pointer
Target * Theme
Font

Width _Sét Variable 3

Height = 0
Target *#

Set Variable 4

® Do | O Aribo Resize
@ If Target #

ESD Label 5

Set Variable' 2. Pointer

o
Target *

Theme
Font

> Auto Resize

Figure 40 - Logic Node Editor
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Library Browser

The Library Browser allows the storing of all the available logic nodes and resources in
ESD that includes both built-in and user-defined ones. Users can view these logic nodes
by category and select one for their project.

Library

B Esp Layouts
B ESD Render Functions
B ESD Theme

S0 Utilities
B ESD Widgets
Logic Flow

Logic Interface
ser Actors
ser Functions

ser Logic

ser Pages

R o

U
0]
User Layouts
U
U
1]

S SOUTCeEs

=
i

S|

Figure 41 - Library Browser

The following table provides the ESD library name and its description -

Library Name
ESD Layouts

ESD Render Functions

ESD Theme
ESD Utilities
ESD Widgets
Logic Flow
Logic Interface
User Actors
User Functions
User Layouts
User Logic
User Pages
User Resources

User Widgets

Description

ESD built-in layout widgets and relevant utilities

ESD built-in Render functions

ESD built-in basic theme manipulation functions

ESD built-in utilities

ESD built-in widgets

ESD built-in logic node for control flow

ESD built-in logic node for interface

User defined actor logic node. It is empty by default.

User defined functions. It is empty by default.

User defined layouts. It is empty by default.

User defined logics. It is empty by default.

Pages added by user. It is empty by default if no page is created.

Resources added by users (For example: bitmap). It is empty by

default.

Widgets created and added by users. It is empty by default.
Table 4 - ESD Libraries
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The Error List is a dock window which shows the message output from ESD, while saving
and recompiling the project files. Any error message displayed in this window indicates
that the generated source code for the current project is unable to be executed
successfully. Users need to double check the logic defined in /ogic node editor or the user-
defined source code in the project.

Error List

Clear

Connection target Condition
Duplicate data input to if (file

Inspector Error List

Figure 42 - Error List Window

The Output component is a docked window which shows the message output from the EVE
emulator and Toolchain.

Quiput

Clear Simulation

Build

To check a message from the EVE emulator, click “Simulation” from the drop-down list.
To check a message from the EVE Toolchain while building generated source code, click
“Build” from the drop-down list. This window is automatically updated during simulation
or building.
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Property Editor

The Property Editor allows user to edit the properties of selected logic nodes. The sample
screenshot given below shows the property editor of an ESD Push button.

Value

ESD Push Button

Ft_Esd_Theme_GetCurr...

27

Button

v True

ESD_OPT_3D
False

1000

Figure 44 - Property Editor (ESD Push Button)

Status bar

The Status bar is found at the bottom of the user interface. It primarily displays the current
status of any process or job that is being handled by the application. For example, if the
user is performing a C compilation, then the compilation status of the generated C code is
displayed.

The percentage of RAM_DL The size of RAM_G memory used Simulation status
memory used by the current page by the current page (whether in progress
I & or not) ¢

BITMAP_HANDLE: 9% 5% 62 kB «" C compilation 100%

The percentage of Flash The compilation status of the

The percentage of bitmap memory used by the generated “C” code. Project
handles used by the current current page cannot be simulated if the
page compilation fails.

Figure 45 - Status bar
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Application Project Structure

An application consists of one or more pages. Each page in turn may contain one or more
widgets. Widgets and pages are connected via connection lines so that the screen logic is
defined.

The application model follows a strict hierarchical structure where all the pages are owned
and managed by the application, and all the widgets are owned by their respective pages.
The visibility and memory lifetime of the widgets are thus managed on a page-by-page
basis.

By design, all widgets and pages are generated to be entirely modular and self-sufficient.
Any interaction between the widgets and pages is therefore required to be routed through
the hierarchical chain. (Only node connections exist between the directly connected nodes
in the hierarchy.)

[ App.main ]

l [:] Application

Page

S | Switch Page Layout

Widget

AppScreen.Page

S
|

Page Page Page

Figure 46 - Application Project Structure

File Name Description

*.esd Project file - This XML file describes what files are included in this project. This
file is unique for the whole project.

*.main Logic file - This XML file describes the application-level logic. By default, it is
named as “App.main” and is unique project wide.

*.page Page Node Definition file - This XML file describes what widgets are contained

and connected in each page. By default: “"AppScreen.Page” is added, where a
switch page may be included for control on page transition. A page can contain
other pages, but switch page is required for page transition control.

*.widget Widget Node Definition file. This XML file describes a widget detail.
A widget can contain other nodes, which may include widget node, actor node
and logic node.

*.actor Actor Node Definition file. This XML file describes the actor node details.
*.logic Logic Object Definition file. This XML file describes the logic node details.
*.theme Application Theme Definition file. This XML file describes the theme detail.
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*.h C language source header file

*.c C language source body file

*.png, Image resource files

*.jpg,

*.jpeg

*.anim Animation file converted by EAB tool

Note: The file names listed above shall NOT be conflicting with the C standard library
function as well as windows header files. Here are some examples: fopen, windows,
winbase, math, printf, realloc. ESD simulation process may give errors and fail, if user
gives the file name of their widgets, logics, images, or any resources with these reserved
names. Therefore, ESD enforces the ‘Usr_’ prefix to all the new/renamed widgets, pages,
functions, actors, as well as source file, theme, logic source file etc, in order to ensure that
the simulation process succeeds without error.

Application Workflow

The workflow given below illustrates how to create an EVE based GUI application:

Screen Logic Node Source JIT EVE Emulator
Layout Editor Editor

O la 1b

A 4 A 4

4>{ Design Layout} —b{ Design Logic

Generator Compiler

2 » Generate C éb Build

4b 4c Y

:

Export 5 i

Figure 47 - Application Workflow

The 5 main modules that comprise the application workflow are the Screen Layout Editor,
Logic Node Editor, Source Generator, JIT Compiler(TinyCC) and EVE Emulator. Among
these, Source Generator, JIT Compiler and EVE Emulator are the back-end modules which
have no UI exposed to end user. The compiler is a JIT style C compiler, i.e., TinyCC
compiler, which compiles and links the generated code into executable. The executable is
invoked by the emulator module for simulation.
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The application workflow starts by design layout (1a) or design logic (1b); Upon user
saving the changes, it will trigger C code generation (2), then the compiler will try to build
the generated c code; if any error encountered during building, then user needs to
continue on design layout (4b) or design logic (4c); or if no error found, then the emulator
will start simulating (4a) the project. Users will be able to upload (5b) the binary to the
EVE chips or export (5¢) the project as eclipse C project.

Design Layout using Layout Editor

Users need to determine how many pages are included in the project and what widgets
are to be contained in each page. After a page is created, users can drag and drop the
widgets to design the appearance of the page in the screen layout editor. This process
determines how many screens are shown in the project and how they look like together.

Custom Widget

ESD provides a set of built-in widgets for users to construct screen layouts. Additionally,
if the built-in widgets do not meet the design requirement, users may define and design
custom widgets.

Add Bitmap Resource

To display a bitmap on the page, users need to add a bitmap resource into the project.
The following steps will provide guidance on how to add a bitmap resource:
. . File Edit Build Too View Help File Edit Build Tools View Help
a. Create a New Project (File > New e v N F,
Project) or open an existing Project ¥ B Add
(File - Open Project). B save cutss | M save
Close Close
o Save All - = Save All
MNew Project ] i
Open Project

b. Click File > Add from the menu. file Edit Build Taol
MNew
B Add b

F
M Save
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c. Browse and select the image file(s) from the file explorer window.

o

N l‘r

RNl Fabhe . Pible Dotunen R B S Dy e | 49 | s0rch Bampies ol

Organize v MNew folder = [l @

B Desktop ® Name Date modified Type Size

4. Downloads ; L
. Advanced 23/172017 337 PM File folder

1 Basic / 17 3:37 PM File folder

. Intermediate 3/1/2017 3:37 PM File folder

___ Recent Places

w Libraries
[ Documents
&' Music
[E=| Pictures
ng Subversion

E Videos

All Files (*.7)
(M Computer Logic (*.logic)

: . Actor (*.actor)
e Local Disk (C:
& Local Disk (€3) Widget (*widget)
—u Recovery (D) Page (*.page)
= HP_TOOLS (E) Application Legic (*.main)
7 C file (*.
¥ Websites (\\glaappsl) (W) E L L )
@ general (V\glafsl\Data) (%) PNG file (*.png}
! PG file (*.jpg)
5® L Subramanian (\SMNGFSIN i PEG file (*.jpeq
i meneral Mennfel \Natal (79 Theme file (" theme

File name: ' All FJ}ES."J I

{ Open ] | Cancel ]

Upon adding the file, users can drag and drop the ESD Image widget to the desired page
and select the bitmap cell (which is default at cell 0) accordingly.

Configure Bitmap Resource

Users can configure a bitmap resource via the Property Editor. Select the image file from
the project browser and check the Property Editor.

Value

Resources/LosAngel...

Bitmap

PALETTEDS63
W True
Falze
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Property
File Name
Name
Category
Format

Compressed

Flash
CellHeight

CellNames

Persistent

Width
Height
Prefer RAM

Value/Description

Name of the image file

Resource Type Name. In this case, the selected resource type is Bitmap.
Category of the selected object

Image Format - The target format of bitmap can be -

L1/L2/L4/L8

RGB332/RGB565
ARGB1555/ARGB2/ARGB4
PALETTED4444/PALETTED565/PALETTEDS8
DXT1

JPEG (Decoded into RGB565 format only)
PNG (Decoded into RGB565 format only)
COMPRESSED_RGBA_ASTC_4x4_KHR
COMPRESSED_RGBA_ASTC_5x4_KHR
COMPRESSED_RGBA_ASTC_5x5_KHR
COMPRESSED_RGBA_ASTC_6x5_KHR
COMPRESSED_RGBA_ASTC_6x6_KHR
COMPRESSED_RGBA_ASTC_8x5_KHR
COMPRESSED_RGBA_ASTC_8x6_KHR
COMPRESSED_RGBA_ASTC_8x8_KHR
COMPRESSED_RGBA_ASTC_10x5_KHR
COMPRESSED_RGBA_ASTC_10x6_KHR
COMPRESSED_RGBA_ASTC_10x8_KHR
COMPRESSED_RGBA_ASTC_10x10_KHR
COMPRESSED_RGBA_ASTC_12x10_KHR
COMPRESSED_RGBA_ASTC_12x12_KHR

Set bitmap compression on/off

Set this to store the resource in the Flash

The pixel number of one cell. For example, if the bitmap width is 240 and

height is 240, then it can be defined as two cells with “CellHeight” - 120 or four

cells with “CellHeight” — 60. Cell Height default at 0 which means there will be

only one cell no matter how large the bitmap it is.

This field will enable system to create a list of n number of user defined cell

names instead system generated which is suffixed with *_x".
CellHeight 20 MochiRiceCakeDXT1_Cell2

* CellMames 3 MochiRiceCakeDXT1_Cell4

[0] CellA MochiRiceCakeDXT1 CellA
(1] Celiz

MechiRiceCakeDXT1_CellC
MochiRiceCakeDXT1_End

[2] CellC
[3] Celld
[4] End

Keeps the memory persistent even if the bitmap is not displayed when it is
true.

The width of bitmap image in pixels

The height of bitmap image in pixels

For ASTC images, resources can be rendered directly from Flash without the
need to store it to RAM_G. If Flash flag is True to load ASTC image from Flash
directly. If Flash flag is False, Resources will be rendered from RAM_G.
Prefer RAM feature is exclusively available for ASTC format alone.

Table 5 - Bitmap Resource Properties
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Design Screen Logic using Logic Node Editor

Users can define the dynamic behaviour of an application in this stage. The Logic Node
Editor employs the innovative visual programming idea to help users define logic flows
without coding.

During this stage, users can decide the behaviour mode of both inner-page and inter-
pages. For inner-page behaviour, users can connect the widgets on the page via the logic
node editor adding more logic nodes from the library browser, if necessary.

Inter-page logic behaviour is captured in the application logic, which is normally named
as “AppScreen.page”. Users are required to drag and drop the predefined pages into the
logic node editor and connect these pages via the logic interface. By establishing
connections between these pages using the logic interface, the behaviour that transcends
page boundaries, such as screen logic, is effectively defined.

Evaluate and choose the memory usage of the project

As mentioned earlier, ESD allows users to configure heap memory usage in root project
properties. It is necessary to decide the memory usage before uploading the image to
hardware. There are several useful debug messages which will be printed in debug mode
which can assist user to make the decision.

CEEETETEEET 8

Figure 49 - memory pool Iog

The above figure illustrates the use of keyword [Esd MemoryPool] for decision making.

To validate the behaviour of the screen logic, users may need to simulate the project on
the PC before compiling and downloading the generated C code into the target device.
When application logic (AppScreen.page or App.main) is selected, users can simulate the
whole project by clicking [Simulation] button on the toolbar. When the application is in
simulation mode, users cannot drag and drop the widgets into the layout editor. The PC
mouse will act as a touch stylus on the touch panel to interact with the application directly.
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To validate the behaviour of single page, users need select the page file and open it with
logic node editor before clicking the [Simulation] button on the toolbar. Similarly, users
can simulate the behaviour of other logic node, such as widget, actor by opening it with
logic node editor and clicking [Simulation] button on the toolbar.

Before performing a simulation, it is strongly recommended to save the current project by
clicking [Save all] button. Once the simulation is completed, ensure to switch off the
simulation mode by clicking the [Simulation] button again.

Simulation State Description

ON State - Indicates that the simulation is in progress. Clicking on it will
switch off the simulation. In this state, users will not be able to edit the
page or project.

- OFF State - Indicates that currently simulation is not in progress.
Clicking on it will switch on the simulation.

Target selection

ESD provides support for the following built-in build targets -

ME810A-HV35R
VM810C50A
ME812A WH50R
ME812AU-WH50R
ME813A-WH50C
ME813AU WH50C
VM816CU50A
VM816C50A
ME817EV-WH10C
10. ME817EV-WH70C
11. Gameduino 3X Dazzler for Pico
12.IDM2040EV-7A
13.IDM2040EV-43A
14.STM32F4

LoNOUnhWN&

These build targets typically come with standard | e x
configuration which the user can modify within [ e e
certain limits as per their requirements. ‘

[ vmei6cs0a

W MEs17EV

M 6 ing X Dazler for Pica
1 ipm2040

ESD also provides a mechanism to create new
custom targets for new ESD projects. For
example, if the user wants to create a new build

ME810A HV35R

EVE Pratform ; EVE Fiash

target “pc_BT815EMU_WVGA” with PC as Host platform, . B % MEBLOA-HV3SR (FIBLO) -
BT815 as EVE platform, Screen Resolution as il 2 e =
WVGA (800 X 480) and Flash set to 16MB = Wi

MX25L16. Refer to the Figure 50 and Figure 51. MM300EV2A

Figure 50 - New Target button
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e Add Target b4

MName: PC_BT815
Description:  Ar

EVE Platform:

RO

[}
7}
o

Ll
Ll
[
L

[

I
ol

ST g

i
@
m

Mew Define

Figure 51 - Configure custom target

The newly created target can then be set via build target. Refer to the screenshot given
below:

MES1TEV-WH10( [ MES17EV = wxea (1 0+ ElFreaz Cwzsqus -
TEV-WHT
© PC_BTS1SEMU_W App.main *
B0 120 160 200 240 280 15 400 440 48D
Figure 52 - Select custom build target

Build & Upload

Run Executable

Figure 53 - Build & Upload
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“Build Executable” button builds a project.

“"Build and Upload to Hardware” button will invoke the compiler and programmer, so
that the current project can be build and uploaded into the target hardware. If user selects
x64 toolchain, this button will build and generate an *.exe’ application which can be run on
a PC as host environment.

For Pico RP2040 platform, ESD will set up the build environment and trigger cmake and
nmake to build Pico project. An Uf2 image file will be generated and flashed to the Pico
MCU, so user needs to enter Pico flash mode before triggering this option. If user has
failed to do this, a dialog will pop up and requesting user to enter flash mode.

Pico drive not exist,please enter bootloader mode

Retry Cancel

Figure 54 - Pico drive not connected alert

The respective output files generated by “Build Executable” for different build configuration
and host platforms are shown in Table 6.

Build Target Host Platform Output files
FT90x toolchain *.bin; *.elf
MEB10A-HV35R Pico toolchain *.uf2
VM810C50A X64 toolchain (MPSSE) *.exe
FT90x toolchain *.bin; *.elf
ME812A WH50R Pico toolchain *.uf2
ME812AU-WH50R X64 toolchain (FT4222) *.exe
FT90x toolchain *.bin; *.elf
ME813A WH50R Pico toolchain *.uf2
ME813AU WH50C X64 toolchain (FT4222) *.exe
VM816CU50A X64 toolchain (FT4222) *.exe
VM816C50A X64 toolchain (MPSSE) *. exe
FT90x toolchain *.bin; *.elf
ME817EV-WH10C Pico toolchain *.uf2
X64 toolchain (FT4222) *.exe
FT90x toolchain *.bin; *.elf
ME817EV-WH70C Pico toolchain *.uf2
X64 toolchain (FT4222) *.exe
Gam_edumo 3X Dazzler Pico toolchain *.uf2
for Pico
IDM2040EV-7A Pico toolchain *.uf2
IDM2040EV-43A Pico toolchain *.uf2
STM32F4 STM32 toolchain *.elf; *.bin

Table 6 - Output files for different Build Configuration & Host Platforms
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Upon completing the screen design, it’s time to move the project to the next phase of the
workflow — export project. There are four ways of exporting a project. They are “Export
as Eclipse Project”, “Export as MSVC Project”, “Export as STM32CubelIDE
Project” and “Export as Pico Project”. This function is used to prepare all the necessary
files for the MCU tool chain so that users can make further enhancements such as
connecting sensors or external hardware to a full HMI solution.

On exporting, ESD copies the generated “C” source code, the necessary bitmap resources
and the ESD application framework code into a user defined folder. In ESD, all the
generated files are named as “*_generated.c”. For eclipse export projects, “.cproject” and
“.project” files are generated so that the users can open the project in FT90X eclipse IDE3.
For MSVC export projects, “Project” folder is generated containing the MSVC compatible
project. For Pico export projects, “CMakeLists.txt” and "“pico_sdk_import.cmake” are
generated for user to build the project. Additionally, an optional batch file “pico_build.cmd”
is also generated. This allows the user to build Pico export project in a single step. And in
order to use this script, system environment variable PICO_SDK_PATH needs to be set as
the pico-sdk path. Another script “pico_flash.cmd” will be generated only if ESD project
has assets in Flash, run this script will flash both the flash image and application into Pico
board, Pico board needs to be under flash mode before running this script. Table 7 gives
more information on the Build Targets, Host platform and the corresponding export
projects that can be created.

Build Target

Host Platform

Export Project

ME810A-HV35R

Emulator

MSVC Project

MM900EV1A, MM900EV1B, MMS0O0EV2A,
MM900EV3A, MM90OEV-Lite

Eclipse Project

MM2040EV Pico Project
VM810C50A Emulator, MPSSE* MSVC Project
Emulator MSVC Project

ME812A-WH50R

MM900EV1A, MM900EV1B, MM9O00EV2A,
MM900EV3A, MM900OEV-Lite

Eclipse Project

MM2040EV Pico Project
ME812AU-WH50R Emulator, FT4222%* MSVC Project
Emulator MSVC Project

ME813A WH50C

MM900EV1A, MM900EV1B, MM9O00EV2A,
MM900EV3A, MM900OEV-Lite

Eclipse Project

MM2040EV

Pico Project

ME813AU WH50C

Emulator, FT4222

MSVC Project

VM816CUS50A

Emulator, FT4222

MSVC Project

VM816C50A

Emulator, MPSSE*

MSVC Project

ME817EV-WH10C

Emulator, FT4222

MSVC Project

MM900EV1A, MM900EV1B, MM9O00EV2A,
MM900EV3A, MM900OEV-Lite

Eclipse Project

MM2040EV

Pico Project

ME817EV-WH70C

Emulator, FT4222

MSVC Project

MM900EV1A, MM900EV1B, MMS00EV2A,
MM900EV3A, MM900OEV-Lite

Eclipse Project

MM2040EV

Pico Project

Gameduino 3X dazzler

Emulator

MSVC Project

3 https://brtchip.com/ft9xx-toolchain/
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Raspberry pi Pico Pico Project

Emulator MSVC Project
IDM2040EV-7A IDM2040EV Pico Project
STM32F4 STM32Cube STM32 Project

Table 7 - Build Targets, Host platform and the corresponding export projects

(* Requires separate MPSSE adapter or FT4222H circuit)

Exported Folder Structure

Table 8 provides the list of folders and files that are created upon exporting the project:

Folder / Files

Esd_Core

FT_Esd_Framework

FT_Esd_Widgets

FT_Esd_Hal
Data
$(ProjectName)

.cproject (for Eclipse export)
.project (for Eclipse export)
ThirdPartyLib

Project/$(ProjectName)_MSVC/
$(ProjectName)_MSVC.sIn
Project/$(ProjectName)_MSVC/
$(ProjectName)_MSVC
/$(ProjectName)_MSVC.vcxproj

CMakelists.txt(for Pico export)
pico_sdk_import.cmake
ThirdPartyLib

pico_build.cmd

pico_flash.cmd

.cproject (for STM32 export)
.project (for STM32 export)
ThirdPartyLib

Core Folders

Drivers Folder

Description
(Common export files)
Contains the application core files.

It is recommended not to make any changes to this folder/
files
Contains the application framework files.

It is recommended not to make any changes to this folder/
files
Contains the widget files

It is recommended not to make any changes to this folder/
files
Contains the hardware abstraction layer files. These files may be
changed to support a different MCU.

Contains the converted bitmap resource data and the flash data
which is used by the current project

Contains the application specific source code
(Eclipse export files)

Eclipse project file

Eclipse project file

Contains third party files such fat filesystem library handler files
(MSVC export files)

MSVC project solution file

MSVC visual studio C++ project file

(Pico export files)

cmake file
cmake file
Contains third party files such fat filesystem library handler files
Build batch to trigger Pico build
Batch to flash both assets and application

(STM32 export files)
STM32Cube project file
STM32Cube project file
Contains third party files such fat filesystem library handler files
STM32 driver startup main files
STM32F4xx HAL Driver files

Table 8 - List of Folder & File created upon exporting project
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Assets

The assets typically include various resources and data files that are bundled with the
application to support its functionality and appearance.

Bitmap Resources

The bitmap resources used in an ESD project can be saved in a SD card or to flash based
on the selection of flash flag configuration in the ESD.

.astc : The ASTC Bitmap Format for images, there is requirement to copy the .astc file to
the SD card or Flash directory.

.z : The .z Bitmap Format, used for compressed images, necessitates copying the .z file
to either the SD card or the Flash directory.

SD card

If Bitmap resources meant for SD card are used in a project, it is converted to *.astc (for
ASTC file format)/*.raw (for other file formats) or *.bin file format (if compressed flag is
selected). Users are required to download the converted bitmap resource into an SD card
root directory and insert the SD card into the hardware module.

The converted bitmap resource is located at:
$(ExportFolder)\data

The bitmap resource file with .bin extension is called to decompress using the EVE engine
command CMD_INFLATE.

As per the Hardware Platform requirements, the SD card must be formatted as a FAT32
file system.

If bitmap resources meant for flash are used in a project, it is converted to a Flash.bin file.
Users are required to download the converted bitmap resource into flash memory of the
hardware module.

The converted bitmap resource is located at:

$(ExportFolder)\data

The bitmap resource file with .bin extension is called to decompress using the EVE engine
command CMD_INFLATE.

Resource Metadata

To support dynamically changing and loading new assets at runtime without binary
recompilations due to hardcoded asset information, EVE Screen Designer generates
additional metadata files with the file extension .esdm appended to the full original
filename for each converted resource.
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The contents of the metadata file correspond to the contents of the Esd_BitmapInfo,
Esd_Resourcelnfo, Esd_FontIinfo, and Esd_AnimationInfo data structures, packed in a
fixed format to fit within 64 bytes. This size restriction allows the metadata to fit within
the directory record of the LittleFS filesystem when in use with flash storage, and simplifies
loading.

Common Resource Metadata Format:

The first 12 bytes contain the common fields used for all assets.

Identifier Offset | Type [ Name Description
ESD_METADATA_SIGNATURE 0 uint32 | Signature Serialized byte sequence
equals "RES", "ANI",
"BMP" or "FNT", NUL-
terminated
ESD_METADATA_VERSION 4 uint8 Version Version of the metadata
format
ESD_METADATA_SIZE 5 uint8 Size Size of the metadata
structure
ESD_METADATA_COMPRESSION | 6 uint8 Compression | The Compression option
in Resourcelnfo
ESD_METADATA_EXTLEN 7 uint8 Extension The string length of the
Length complete file extension
of the resource
ESD_METADATA_RAWSIZE 8 uint32 | Raw Size The uncompressed size
of the resource, RawSize
in Resourcelnfo

Bitmap Resource Metadata Format:

The bitmap resource metadata format builds on the common format, and has all the
necessary data to populate the Esd_Bitmaplnfo structure.

Identifier Offset | Type Name Description
ESD_METADATA_WIDTH 12+0 int32_t Width Display width in pixels
ESD_METADATA_HEIGHT 12+ 4 int32_t | Height Display height in pixels
ESD_METADATA_STRIDE 12 +8 int32_t Stride Stride of the bitmap
data in bytes
ESD_METADATA_FORMAT 12 + 12 | uint32_ | Format Format of the bitmap
t data
ESD_METADATA_PALETTESIZE 12 + 16 | uintl6_ | Palette Size Uncompressed size of
t the palette file
ESD_METADATA_PALETTEFILEE | 12 + 18 | uint8_t[ | Palette File Filename suffix of the
XT 10] Extension palette. Concatenated

to the bitmap filename
trimmed by Extension
Length (Paletted)

ESD_METADATA_ADDTLRESEXT | 12 + 28 | uint8_t[ | Additional Filename suffix of the
12] Resource additional bitmap info
Extension resource. Concatenated

to the bitmap filename
trimmed by Extension
Length (DXT1)
ESD_METADATA_CELLS 12 + 40 | uintl6 Cells Number of cells usable
by the user (up to 256
pages of 256 cells),
excluding hidden cells
(e.g., hidden DXT1
layers)
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ESD_METADATA_SWIZZLE 12 + 42 | uintl6_ | Swizzle Swizzle, same 12-bit

t format as
BITMAP_SWIZZLE, plus
one bit to enable the
option

Animation Resource Metadata Format:

The animation resource metadata format specifies the address offsets that the animation
was built with when assembling the flash image. It is currently only used to verify that the
animation matches its current location in flash. The ESD build process adjusts these offsets
on-the-fly while assembling the flash image. At this moment, ESD only supports displaying
animations directly from flash.

Identifier Offset | Type Name Description
ESD_METADATA_FRAMESPTR 12+ 0 uint32 Frames Ptr | The address of the
frames file that the
object file was built
with. Refers to a
RAM or flash
address depending
on whether the
header object is
loaded in RAM or

flash
ESD_METADATA_FRAMESSIZE 12+ 4 uint32 Frames Size of the display
Size list frames file, if O

both frames and
atlas files are

ignored
ESD_METADATA_ATLASBITMAPSOURC 12 + 8 uint32 Atlas The address in
E Bitmap bitmap source
Source display list format

(can be flash or
RAM) of the atlas
file that the frames
file was built with
ESD_METADATA_ATLASSIZE 12 + 12 | uint32 Atlas Size Size of the ASTC
bitmap atlas file, if
0 the atlas file is

ignored
ESD_METADATA_RECTX 12 + 16 | intl6 Rect X Display list bounds
of the display list
frames
ESD_METADATA_RECTY 12 + 18 | intl6 Rect Y Display list bounds
of the display list
frames
ESD_METADATA_RECTWIDTH 12 + 20 | int16 Rect Width | Display list bounds
of the display list
frames
ESD_METADATA_RECTHEIGHT 12 + 22 | intl6 Rect Display list bounds
Height of the display list
frames
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Font Resource Metadata Format:

Specifies font measurement characteristics that are not present in the font block, used by
ESD to correctly align and centre fonts.

Identifier Offset Type | Name Description

ESD_FONT_EXTENDED | 12 + 0 uint8 | Type Type of font to load (Legacy or
Extended)

FontHeight 12+ 4 uint8 | First Char | First character in the glyph map (for
legacy fonts)

BaselLine 12 +8 uintl6 | Base Line | Baseline, distance from top of font
glyph

CapsHeight 12 + 16 | uintl6 | Caps Caps height of font, measured from

Height baseline

XOffset 12 + 20 | uintl6 | X Offset Offset of left edge of characters in the
bitmap

FontResource ... Font

GlyphResource ... Glyphs

Layout Editor

The Layout Editor allows users to preview a single page as well as the whole project. ESD
employs the EVE emulator to render an EVE display onto the layout editor. It provides
users, the interface to view the result of the screen design and its logic.

The following file types are displayed in ESD layout editor:

o Application logic file - generally with “.main” extension
e Page file - generally with “.page” extension

Page File

Page stands for a single screen which will be rendered. One application consists of at least
one page. Page may have its own life cycle and manages all the widgets on it. Only widgets
can be dragged and dropped into pages at Page layout editor. However, all the nodes from
a library can be dragged and dropped into the logic node editor.

“Active” Property

The "“Active” property is a Boolean value to control the page, and is created or released
while the application is updating the pages. By default, the “Active” property is True. The
page is created and shown, unless “"Switch” end is connected.
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Switch Page

Users can define multiple pages within the project. "Switch
Page” ESD layout should add to manage the pages. User can
drag and drop the pages into this switch page from project
The picture below displays how the logic editor

browser.
view looks like for the switch page logic.

Figure 55

App.main AlarmPage.c AppScreen.page™

SystemPage

Painter

Width
Height

BottomMenu

Pointer

AlarmManager.
AlarmManager.c
AlarmPage.c
AlarmPage.page

I Hal'rF'uI" g
E SetPage.c
< | SetPage.page

- Switch Page

Fuointer

0
0

Height

[} Activate

Width
Height

Figure 56 - Sample Switch Page UI

Page Persistence

To allow a page to remain in memory with its current state even when it is made inactive,
set the allocation mode to “Lazy Persistent” or “Static” from the application logic in the
page's Properties. This feature can help users to reserve the information of a page even

when it is not visible.
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ase

App.main

Rorte

Error List 6 Output 1

Figure 57 - Properties Editor — Page Allocation

The page allocation modes supported in ESD are listed in the table given below:

Allocation Mode Description

Static Page is always persistent in memory after application starts

Lazy Page is created when it is in “active” state and destroyed when it is
inactive

Lazy Persistent Page is created when it is in “active” state but persistent in memory

when it is “inactive” until application is closed.

User Defined Function for Page File

Users can write their own code to handle the “Pushed” signal of the “ESD Push Button”
widget. Users are required to select the "ESD Push Button” widget in the logic node editor
and double click it. A function will be generated to replace the user defined function.

ESD METHOD (MainPage ESD Push Button Pushed, Context = MainPage)
void MainPage ESD Push Button Pushed (MainPage *context)
{

// Users can write their code here

The code can be located at $(PageFileName).c file.

MainPage.page® App.main *° MainPage.c

-

ESD METHOD(MainPage ES shec t = MainPage)

id MainPage ES

Figure 58 - Sample Source File
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Zoom In & Out

The visual area of the screen layout editor can be zoomed when the current file is a page
file, i.e., ".page” file. The mouse wheel button provides zoom-in and zoom-out
functionality, allowing users to view more details about the screen design. Refer to the
sample picture given below:

Appimain

3. g[l 3 -‘I‘ 490 4?0 4‘40 -lIBD -llﬂﬂ S‘DD 5‘20 540

Fiiure 59 - Zoom In & Out

To view the application logic file (*.main) file, double click the file within the project
explorer. The screen layout editor will show the first page defined in the logic node editor.
To view how the application logic is defined, click the “Simulation” button and check it
in the screen layout editor.

File Edit Build Tools View Help

| TR P C ) Py i Ll MEBI2AWHSOR ¥ | FT90xRelease ¥ FT900 Ore-Wire =

o

App.main

rFYyvwvwvwvwwy

Width

5 Height
‘B testtheme

{Linked File Proxy)
File Name App.main
Display Mame

ment

Error List
Clear Callapse ® 0Erors | 4k 0 Warnings S ea Simulation =
Pte Ltd. Category
Default Signal
Icon

Inspector Error List

BITMAP_HAMDLE: RAM_DL: [ RAM_G: 0% +" C compilation 100% * Render

Figure 60 - Main File
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Logic File

The logic file contains certain logic that is used to encapsulate the user defined logic. It
works similar to a C function. A logic file does not render any user interface.

Ft_Esd_FiedPaintiumericLabel.c MainScreen.page Ft_Eed_IntCounter.fogic

Set Variable

Signaled [}

[+1Plus

Set Variable

[-1 Minus.

Result

Figure 61 - Sample Logic File

The screen layout editor provides a simple C editor when users double click a “.c” file in
the project browser. Note that it is not a full-fledged C editor and many features may be
implemented in the future.

File Edit Build Tools View Help
i &= & 2 ) # MES12AWHSOR ¥ | FT90xRelease ~ FTS00 One-Wire =
Project

v [ BasicMath.e
3

~ W F1Esd Widgetsesd Simple C
Editor

- E=d_ColorPicker.c *

Figure 62 - C File / C Editor

~ ' # To effect the changes made, ensure that all the changes are saved to the project
by clicking “File = Save All” from the menu or from the toolbar.
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Logic Note Editor

Using the Logic Node Editor (LNE), users compose screen logic by connecting logic nodes.
The Logic Note Editor is designed to open the following file formats:

Application logic file , *.main file
Screen logic file, *.page file
Widget file, *.widget

Actor file, *.actor

User defined logic file, *.logic file

Basic Logic Node

ESD has some built-in predefined basic logic nodes. These basic logic nodes provide basic
control flow and logic interfaces as well as basic functions. A typical basic logic node is
represented in the logic node editor as below, the name of which is shown in white.

Ft_Esd_Dl_COLOR_ARGB
O cal m

Color

Figure 63 - Logic Node Editor - Basic Logic Node

Within the library browser, the basic logic nodes are located at "Logic Flow”, “Logic
Interface”, "ESD Utilities” and "EVE Render Functions”.

Fite Edit Build Tools View Help

# MEB12AWHSOR ~ | FTS0x

App.main * ColorPic

rage

page
B MainPage.page

MoE oM e

Figure 64 - Library Browser - Basic Logic Nodes

Composite Logic Node

A Composite Logic Node is made up by connecting multiple basic logic nodes. A typical
composite logic node is defined in a standalone document in XML format and is shown in
the logic node. Refer to the picture given below -
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ESD Push Button
Active L

Down [
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Pushed []

|
X

v

Width
Height
Font
Text
Primary

Figure 65 - Composite Logic Node

The following are the different types of composite logic nodes defined in ESD 4.14:

Page Node
Widget Node
Layout Widget
Actor Node
Logic Object

Page Node

When users create a single page, it is represented by a logic node under the “User Page”
category in the library browser. Users can connect one page node to another within the
logic node editor. It has its own property and defined output.

AppScreen

Painter

=
O

Width
Height

Figure 66 - Composite Logic Node - Page Node

Widget Node

The Widget Node is one type of logic node which has visual appearance and is able to
handle user input. It has the built-in Start, Update, Idle, Render and End slots.

For more information on built-in slots, please refer to Built-in Slot.
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Within the logic node editor, the widget name is highlighted with the colour title as
shown in the sample picture below -

Library
B &

Theme
Alpha
Hours
Minutes
Seconds
Miiis econds
Interective
Active
X
¥

- Width

Start Height

AutoResize

[3: 3 | [o: 1o 1 | T8

% oEmos M\ owamings @ C

164

Ft_ksd_Iheme,
55

15

60

Inspector | Error List

Figure 67 - Logic Node Editor — Widget Node

The highlighted sections provide information on adding user widgets; the position and size
properties; rendering the widget and widget theme.

Adding User Widgets

File Edit Build Tools View Help
A User Widget, also called as custom New b B Logic
widget is a reusable user interface
element created by a user. To create a
widget, from the menu, click and select
“File > New > Widget”. Sloes BN Page

= Save All “® Theme

New Project B SourceFiles

Giiien Droect B Logic Source Files

B Add B Actor
F
™ Save CteleS [ Widget

In order to make use of these slots, users need to drag the slots from the library browser
and drop them into the logic node editor. By renaming it to the slot defined above, users
can connect widget control flow to application control flow.

Position & Size Properties

As a user interface element, widgets have at least position and size properties so that
users can control them using a visible handle. Position property is defined by an “Input”
node with “ft_int16_t"” type named as “X” or “Y". Size property is defined by an “Input”
node with “ft_int16_t" type named as “Width” or “Height”. Figure 68 provides a sample of
the “"X” property.
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Properties

Property Value

(Input)

MName X

Display Name

Comment

Type ft_intl6_t
Edit Role

Min

Max

Single Step

Default

Figure 68 - User Widget - Position & Size Properties

Rendering a widget

Rendering of a widget may be implemented fully in the logic editor, or directly in the code
using the logic editor to glue together the code with the generated structures. To create
the render function, simply add a Slot from the Logic Interface category of the library
browser, name it "Render” and double click to create the user method for handling the
rendering. The widget is expected to restore any graphics state it changes, with the
exception of the state values specified below.

Preferably use the Ft_Esd_DI_ utility functions for display list drawing when available.
Several state parameters which may be expected to be changed often to the same value
implement de-duplication here to shorten the display list. The de-duplicated values
are: Palette source, Color RGB, Color A, Handle, Cell, and Vertex Format. These graphic
state values are not required to be restored to their original values when the Ft_Esd_DI_
functions are used. These values should be expected to be any undefined value at the
start of the Rendering function. Access the value of the X input property as given below:

int x = context->X(context->Owner) ;

This calls the get () function assigned by the parent to the X property, passing the owner’s
context to the function to handle it there.

Theme

Widgets should provide property input to override the default application theme. An input
property with type Ft_Esd_Theme * should be added by dragging one input node from the
“Logic Interface” category of the library browser. Colours from the theme may be accessed
from the logic editor using the utility functions under the ESD Theme category, or from
the user code as given below:

Ft Esd Theme *theme = context->Theme (context->Owner) ;
if (theme == NULL) theme = Ft Esd Theme GetCurrent();
ft rgb32 t primaryColor = theme->PrimaryColor;

Touch Input

In order to handle the touch input, add a Touch Tag node from "ESD Utilities” category of
the library browser to the logic editor, and either handle the signals or access its state
through the Touch Tag interface. Users need to make use of the “Tag” value provided by
the “Touch Tag” node during the Render function, and restore the “Tag” to value 0 after
the relevant portion of the rendering.
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To handle any of the signals from Touch Tag in user code, simply create an ESD_METHOD
style function in the same format as the Render user code function, and it will be available
from the User Functions category in the library to drag into the logic editor and connect to
any of the signals from the Touch Tag node.

Layout Type Widget

Layout widget is a layout container for widgets. Unlike widget nodes which have visual
appearance, a layout widget manages the layout specification for its child widgets. Layout
widgets are introduced since ESD 4.0. Figure 69 & Figure 70 displays the various layout
widgets supported in ESD.

B {8 B B [ [ [ |

App.main™ Ft_Esd_ColorPicker.c

Fill Layout Fixed Positioning Linear Layout Scroll Layout

Painter Pointer Pointer Pointer
Active Active Active

¥ 3 3 ¥
Width { Width
Height Height

Stretch

Painter Pointer

RangeX
RangeY

Width

Height

Seroll.. hanged
Seroll.. hanged

Figure 70 - Layout Widgets

Actor Node

Actor type is an extended type of logic node which functions similar to the widget node,
but without the Render slot. Therefore, it has no visual appearance. When users create a
new actor node, it does not show in the layout editor. It has the built-in Start, Update,

Product Page 72
Document Feedback Copyright © Bridgetek Pte Ltd



0’ -
::< BrldgEtek BRT_AN_029 EVE Screen Designer 4.19 User Guide
‘0

BRIDGING TECHNOLOGY Version 1.8

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Idle and End slots which are not available in a regular logic node. For more information
about built-in slots, please refer to Built-in Slot.

An Actor node is useful for implementing both continuous and background running
behaviours, such as animations, timers, and input data polling. The actor node name is
highlighted with the yellow colour within the logic node editor.

Active
@ Play

Value

Figure 71 - Actor Node

To create an actor, from the menu, click and select “File > New > Actor"”.
File Edit Build Tools View Help
MNew P B Logic

B Add W Actor

™ Save @ widget
@ Page
@ Theme
B Source Files

Open Pioject B Logic Source Files

~ " # Refertothe example project “ActorAnimator.esd” under the “EVE Screen
~ Designer — Examples — Basic — ActorAnimators” folder for adding and using
actor node.

Logic Object

A Logic Object is a basic logic block designed to express certain logic which has NO built-
in slot. Hence, it is not possible to invoke it through the built-in render slot or update slot.
However, it may have its own private or public property and output, signal and slot,
depending on the users’ implementation.

A logic object is generally used to simplify complex logic by splitting it into multiple smaller
and simpler logic objects. It is defined and saved in a “*.logic” file.

Within the logic node editor, the logic object name is highlighted with the grey colour.

Switch Bitmap Cell
Bitmmap Cell

Cell

Figure 72 - Logic Object

To add a logic object, from the menu, click and select “File > New - Logic”.
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Connections

Connections are lines between two nodes. The connection line’s colour is determined by
the ends. The following table provides the different types of ends and their description.

Connection Line End Description
Type
. ﬁ Event slots and signals are implemented as functions which only

Event slots and Signals take a pointer to the node context as a parameter. The node
context contains the state of the node as well as a pointer to the
parent node to signal back.

oo . Data property input and output bindings are implemented as get-

Data property bindings functions which only take a pointer to the node context as a

/ / parameter and return a value. This means that these connections
are completely evaluated every time the property is read, and

consequently the property always reads as the latest value. A

buffer variable can be used to cache values if necessary. The

different colours denote the different data types.

Variable write The write interface is translated into a function pointer during the
code generation. Variables are plain variables, which can be
written using the Set Variable node. They may also be set through
the Writer interface which is implemented using a pointer to a
set-function.

Table 9 - Connection End Types

In general, all of the input properties that can be connected can also be specified from the
property editor when they are constant values; this is sometimes referred to as the
“Default” value. In addition, it is possible to specify the Minimum and Maximum values for
the input bindings and variables.

Rendering Order

In the application logic file "App.main”, the pages added on the MainPage
logic node editor are to be represented with the symbols shown Pointer
in the sample picture. c

O
O

When there are more than two pages, the order in which the
pages were created determines the rendering order.

Width
The following implicit rule of the logic node editor is worthy to Height
be noted, since this rule applies to all the logic nodes.

“"Depth Sort” is used to determine the rendering order of the logic nodes. The
greater the value of “Depth Sort”, the later the logic node is rendered and higher
the layer in which it is shown. When logic nodes have the same “Depth Sort” value,
the logic node’s “X”/ “Y"” coordinate (within layout widget) determines the
rendering order. The page node with the lowest value of the “X”/ “Y” coordinate is
rendered first (as lower depth value).
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ToggleMainPags

Figure 73 - Rendering Order Example

Logic Note Editor - User Interaction

The Logic Node Editor enables Zoom-in and Zoom-out functionality. Users can make use
of the mouse wheel button to zoom in and zoom out.

“Panning” the logic node editor screen helps reveals the parts of the logic node editor
which could not have been fit in a single screen. Panning can be done by 2 ways:

(i) Press Alt Key + Left mouse button and move the mouse
(i) Press the middle mouse button and move the mouse.

User can select multiple node items in the logic node editor by pressing Control key and
selecting the desired objects by left mouse button click. Single/multiple objects can thus
be moved if needed by moving the mouse while pressing the Left mouse button.

Avoid two connections connecting to the same port. Refer to the sample
picture given below.

Active

Theme

Font
Text

DON’T

Height

s ) Alignx

O AbgnY

Unary Operator

Valus Result
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Avoid endless dead loops caused by connecting the input and output of
the same object. It will cause an unexpected error. Refer to the sample
pictures given below.

Set Variable

Ternary Operator

U It True
Value If Fake

~ To effect the changes made to the logic note editor, ensure that all the changes
are saved to the project, by clicking “File = Save All” from the menu or toolbar.

In some cases, click the “Recompile” button to recompile the source code
generated by ESD.

Library Browser

The Library Browser consists of the basic components
which are predefined and built in as part of ESD 4.14, as
well as user defined components and/or resources. The
components in the library include Theme, Primitive,
Widgets, Logic Flow and Logic Interface. Users can select
the appropriate components and drag them into the logic
node editor or layout editor.

The library view depends on the currently selected node.
The library browser will only show the contents which
applies to the currently opened node.

Figure 74 - Library Browser
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In the Library Browser, items can be filtered by entering the search text in the textbox.
Regular expression is supported. The matching text is highlighted as shown in the sample
picture given below -

Library

pallara

| ESD Render Functions
B Elements

|| Ft_Esd Element: ient_Panel

i (Rounded)
ient Rectangl d Point)
ent Rectangle (Integer)

Figure 75 - Library Filter

The forthcoming sections provide information about the different components of the library
browser.

ESD Layouts

ESD Layouts contains the collection of ESD layout widgets and [EGEGY
layout utilities functions.

EV Language Resource

Auto Switch Widget
Dynamic Switch Page

W Switch Page
B scroli Switch Page
| Signal Switch Page

Layout Description
Dynamic Switch Page ' This Layout is used to achieve a fade-in/fade-out animation from one
page to another page

Fill Layout This layout is used to fill up the whole widget display region
Fixed Positioning This layout is for fixed coordinate layouts
Linear Layout This layout supports both horizontal and vertical layouts
Scroll Layout Specific layout for scrollable panel
Stretch This layout supports both horizontal and vertical layouts
Switch Page To manage page switching logic
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Scroll Switch Page This layout supports scroll between pages according to the swipe
direction.
Signal Switch Page This layout support switch between pages via signals, can be set as

vertical switch or horizontal switch.

There are also layout utilities and advanced layout features provided in ESD Layouts
collection. These sections are for advanced user only.

Layout utilities are a set of helping functions to ease the development of layout. Users can
build their own layout widget by making use of them. There are several items defined for
sorting widget’s purpose.

Utilities

ESD provides various Layout utility functions while
designing layouts.

orizontal Align
1 Align

Height

L

Get Horizontal Align

The Get Horizontal Align utility is used to align the widget Get Horizontal Align
horizontally.

) align

The function can be called as shown below:

ESD FUNCTION (ESD ALIGN HORIZONTAL, Type = Esd AlignHorizontal, DisplayName
= "Get Horizontal Align", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (align, Type = Esd Align)

#define ESD ALIGN HORIZONTAL(align) (align & 3)

Get Vertical Align

The Get Vertical Align utility is used to align the widget Get Vertical Align
vertically.

2 align

The function can be called like below:

ESD FUNCTION(ESD ALIGN VERTICAL, Type = Esd AlignVertical, DisplayName =
"Get Vertical Align", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (align, Type = Esd Align)

#define ESD ALIGN VERTICAL(align) (align & 12)
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The Detach utility is used to detach the widget from the Detach
current parent layout I call

Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget Detach, DisplayName = "Detach", Category =
EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget Detach (Ft Esd Widget *context);

Get Global Height

The Get Global Height utility is used to get the global X co- Get Global Height
ordinate of widget. %

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalHeight, Type = ft intl6 t, DisplayName
= "Get Global Height", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalHeight (context) (((Ft_Esd Widget
*)context) ->GlobalHeight)

Get Global Width

The Get Global Width utility is used to get the width of the Get Global Width
widget. comtext

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalWidth, Type = ft intl6 t, DisplayName =
"Get Global Width", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget *)

#define Ft Esd Widget GetGlobalWidth (context) (((Ft Esd Widget

*) context) ->GlobalWidth)

Get Global X

The Get Global X utility is used to get the global X co- Get Global X
ordinate of the widget.

context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalX, Type = ft intl6 t, DisplayName =
"Get Global X", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget ¥*)

#define Ft Esd Widget GetGlobalX(context) (((Ft Esd Widget

*) context) ->GlobalX)
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Get Global Y

The Get Global Y utility is used to get the global Y co- Get Global Y
ordinate of the widget. itk

The function can be called like below:

ESD FUNCTION (Ft Esd Widget GetGlobalY, Type = ft intlé6 t, DisplayName =
"Get Global Y", Category = EsdLayoutUtilities, Macro)

ESD PARAMETER (context, Type = Ft Esd Widget ¥*)

#define Ft Esd Widget GetGlobalY (context) (((Ft Esd Widget

*) context) ->GlobalY)

The Insert at Above utility is used to insert a widget above TERSEE I
the specified sibling widgets in the sibling widgets parent
layout.

ESD FUNCTION (Ft Esd Widget InsertAbove, DisplayName = "Insert Above",
Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (sibling, DisplayName = "Sibling", Type = Ft Esd Widget *)

void Ft Esd Widget InsertAbove (Ft Esd Widget *context, Ft Esd Widget
*sibling) ;

Insert Below

Insert Below

The Insert at Below utility is used to insert a widget
below the specified sibling widgets in the sibling
widgets parent layout.

The function can be called like below:

ESD FUNCTION (Ft Esd Widget InsertBelow, DisplayName = "Insert Below",
Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (sibling, DisplayName = "Sibling", Type = Ft Esd Widget *)

void Ft Esd Widget InsertBelow (Ft Esd Widget *context, Ft Esd Widget
*sibling) ;

Insert at Bottom

Insert at Bottom

The Insert at Bottom utility is used to insert a widget
in the bottom position of the specified parent layout.

Parent

The function can be called like below:

ESD FUNCTION (Ft Esd Widget InsertBottom, DisplayName = "Insert at Bottom",
Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

ESD PARAMETER (parent, DisplayName = "Parent", Type = Ft Esd Widget *)

void Ft Esd Widget InsertBottom(Ft Esd Widget *context, Ft Esd Widget
*parent) ;
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The Insert at Top utility is used to insert a widget in Insert at Top
the top position of the specified parent layout. O call

. . /' :||;|Et
The function can be called like below: Btk
ESD FUNCTION (Ft Esd Widget InsertTop, DisplayName = "Insert at Top",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
ESD PARAMETER (parent, DisplayName = "Parent", Type = Ft Esd Widget *)

void Ft Esd Widget InsertTop(Ft Esd Widget *context, Ft Esd Widget
*parent) ;

Is Bottom

The Is Bottom utility returns FT_TRUE if the widget is Is Bottom
the bottom widget within the current parent layout. Widaet

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsBottom, Type = ft bool t, DisplayName = "Is
Bottom", Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

ft bool t Ft Esd Widget IsBottom(Ft Esd Widget *context);

Is Top

This Is Top utility returns FT_TRUE if the widget is the topmost
widget within the current parent layout Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsTop, Type = ft bool t, DisplayName = "Is Top",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

ft bool t Ft Esd Widget IsTop (Ft Esd Widget *context);

Is Visible

The Is Visible utility is used to check if the widget is Is Visible
within the current screen scissor area.

context

The function can be called like below:

ESD FUNCTION (Ft Esd Widget IsVisible, Type = ft bool + t, DisplayName = "Is
Visible", Category = EsdLayoutUtilities)

ESD PARAMETER (context, Type = Ft Esd Widget ¥*)

ft bool t Ft Esd Widget IsVisible(Ft Esd Widget *context);
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Sort Higher

The Sort Higher utility is used to sort the widget above Sort Higher
its current sibling within the current parent layout. =
The function can be called like below: L Cal

Widget

ESD FUNCTION (Ft Esd Widget SortHigher,
DisplayName = "Sort Higher", Category = EsdLayoutUtilities)

ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)
void Ft Esd Widget SortHigher (Ft Esd Widget *context);

Sort Lower

The Sort Lower utility is used to sort the widget below Sort Lower
its current sibling within the current parent layout. [ cal
Lo
The function can be called like below: Widget
ESD FUNCTION (Ft Esd Widget SortLower, DisplayName = "Sort Lower", Category
= EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortLower (Ft Esd Widget *context);

Sort to Bottom

The Sort to Bottom utility is used to sort the widget to the Sort to Bottom
bottom within the current parent layout. O call

Widget

The function can be called like below:

ESD FUNCTION (Ft Esd Widget SortToBottom, DisplayName = "Sort to Bottom",
Category = EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget ¥*)

void Ft Esd Widget SortToBottom(Ft Esd Widget *context):;

The Sort to Top utility is used to sort the widget to the top Sort to Top
within the current parent layout.

The function can be called like below:

ESD FUNCTION (Ft Esd Widget SortToTop, DisplayName = "Sort to Top", Category
= EsdLayoutUtilities)
ESD PARAMETER (context, DisplayName = "Widget", Type = Ft Esd Widget *)

void Ft Esd Widget SortToTop (Ft Esd Widget *context);

Switch Page

The Switch Page is a special layout which focuses on page/widget transitions. By default,
there will be only one Switch Page layout in “AppScreen.Page” in every ESD project.
However, this is optional and the users can remove or change the switch page layout in
the project. Refer to the example project "EVE Screen Designer - Examples > Basic
- MenuPage > MenuPage.esd -> AppScreen.page” for a switch page demo.
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Library Switch Page
s Pointer

Utilities

Fill Layout

Fixed Positioning Width

Linear Layout Height

Scroll Layout Spininer

Stretch Sdssor

= Sl Pane AutoResize
Property Name Description
Pointer The pointer reference of the widget object
Active Enable or disable displaying this widget
X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width
Height Widget Height
Spinner Set true to show spinner/loading icon when switching page. This is
useful user indication when a page has heavy resource.

Scissor Set true, to trim off any content is drawn outside the layout region.
Auto Resize Set true, to enable auto resize for this layout.

Table 10 — Switch Page Layout Properties

Switch Page Implementation

1. Set page/widget into Switch Page

Unlike widgets, Switch Page cannot be dragged on Screen
Layout Editor or Logic Editor. In order to put a page under

the control of the switch page layout, the user has to use - Eﬁ'itCh_pagE_

. . . . . i UserPage
Project Browser instead, drag the widget into the switch B Main Page
page layout. ‘B DefaultThemetheme

2. Page Resource

Properties

Property Value

Since ESD 4.0, a page resource allocation can be:
\larm Static
e Static — always load at the start Allocation

Lazy - allocate when it is active, and free it when it is Depth Sort

Lazy

Lazy Persistent

inactive. Active e

e Lazy persistent - allocate when it is first time active, and il

it will remain in system until reset.

v
Width
Height

When a new page is activated, its parent object, the Switch
Page will also mark the current page as inactive and free it from memory when it has
“Lazy” mode of allocation.
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Dynamic Switch Page

The Dynamic Switch Page is a special layout which focuses on page/widget transitions.
The primary purpose of this widget is to achieve a fade-in/fade-out animation while
transiting from one page to another page. Like Switch Page widget, only one of the children
of Switch Page would be visible at any point of time. But unlike Switch Page widget which
abruptly changes the visibility between the transiting pages, Dynamic Switch Page widget
will fade-in and fade-out the new to-be-visible page and old not-to-visible page.

Library

Dynamic Switch Page
Pointer
Active
/@ Dynamic Switch Page X
W Fill Layout Y
; - Width
Height

Scroll Laj,-n:nut
Stretch AutoResize

chifage Animration D...
oll Switch Page

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels

Y Y coordinate of the top-left of the widget, in pixels

Width Widget width

Height Widget Height

Auto Resize Set true, to enable auto resize for this layout. -

Animation Duration Sets the time within which the animation needs to be finished.

Table 11 - Dynamic Switch Page Layout Properties

Dynamic Switch Page Implementation

., .
b == App.main

1. Set page/widget into Dynamic Switch Page - 3 ﬁ"pp&reen-page
Actors

- onnections

Unlike widgets, Dynamic Switch Page cannot be dragged on
Screen Layout Editor or Logic Editor. In order to put a page Widgets
under the control of the switch page layout, the user has to W Dynamic Switch Page
use Project Browser instead, drag the widget into the g I;'QQ'.:F'E?E
Dynamic switch page layout. e

2. Page Resource e Value
Since ESD 4.0, a page resource allocation can be: - Sl
Allocation Lazy
. Depth Sort sz
Static - always load at the start v Lazy Persistent
e Lazy - allocate when it is active, and free it when it is 0

inactive. 0
e Lazy persistent - allocate when it is first time active, and
it will remain in system until reset.

When a new page is activated, its parent object, the Dynamic Switch Page will also mark
the current page as inactive and free it from memory when it has “Lazy” mode of
allocation.
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Auto Switch Widget

The Auto Switch Widget is a [Bekel =) Auto Switch Widget
layout which focuses on rapid [BES
transitions between its child
widgets. The primary purpose
of this widget is to rapidly
activate its child widget one by
one in the order of its depth.
The rate of change is set by
the user. This can be used to
generate a gif like animation
effect. A sub. But unlike Switch — S 1
Page and Dynamic Switch e
Page, the transition between <
child widget is automatic and not tnggered Use case of the widget can be found in
Examples/Basic/AutoSwitchLayout.

Pointer

Width
Height
Animation F...

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinates of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Animation Frequency Sets the rate of change of child widget activations

Table 12 - Auto Switch Page Layout Properties

Auto Switch Page Implementation

1. Set widgets into Dynamic Switch Page

Auto Switch widget can be dragged on Logic Editor. In order to
put a widget under the control of the switch page layout, the
user has to use Project Browser instead, drag the widget into
the Auto Switch Widget layout.

2. Widget Rendering order T EDLH'

All child widgets are activated one by one and rendered in a sequence according to their
depth orders. Thus, to rearrange the order of activation, user needs to update the depth
order of the children widgets.

Fixed Positioning

The Fixed Positioning is a layout widget which allows its child widgets to be fixed at design
time. By default, every page starts with one fixed positioning layout, such that all widgets
under the page are placed at design time. Fixed Positioning layout does not update its
child widget’s dimensions on runtime. Users should get what they see on design time, on
runtime as well.
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b o= App.main | ESD Layouts
r AppScreen.page |
‘8 DefaultThemetheme [

v [ FirstPage.page iE

[ o

Actors _ Fieed Positioning
onnections III Linear Layout

B scll Layout Width

Height

Switch Page

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Table 13 - Fixed Positioning Layout Properties

Fixed Positioning Implementation

1. Set page/widget into Fixed Positioning Layout PEIEEthpage
aultTheme.theme
Drag and drop a new widget into the Screen Layout Editor
will be the highest depth sort widget in the layout by
default. However, the depth sort values are configurable
by the users. If a widget is not in fixed positioning layout,
the Screen layout editor will not able to change it is position
as it desired. Always check on project browser as picture
on the right.
2. Change Child Widgets’ depth sort

Changing the depth sort value of child widgets will affect their rendering sequence. This
functionality is same as in ESD 3.0.

Fill Layout

The Fill Layout is the base Ea ey
layout for every W Subyaried
widget/page since in ESD. :T:'[“:
A widget always comes e

with a Fill Layout in it. =
However, a fill layout in a =
page has a fixed size due BT ctreich
to the screen size defined
from the hardware. All
widgets in the Fill Layout will auto resize to fit the whole layout area.

Hll Layout

Width
Height

Switch Page
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Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Table 14 - Fill Layout Properties

Fill Layout Implementation

I Widgets
1. Change Widget sequence + I Fill Layout
@ ESD Clock
The fill layout sequence is ordered in the sequence of widgets’ B ESDImage

depth sort. Changing a particular widget to a higher
depth sort value, will increase the priority widget’'s
rendering. The example below shows a clock widget and
an image widget under the same Fill Layout. Both
widgets are filling up the full “Fill Layout” area.
However, by setting the depth value of clock widget
bigger than the image widget’s depth sort, the clock
widget will be rendered on top of the image widget.

Linear Layout

The Linear Layout supports
both horizontal and vertical
alignment in ESD. All child
widgets will be distributed in
the selected orientation. Users
cannot change the sequence

Fixed Positioning

Linear Lay

. . . Scroll Layout
of widgets in the linear layout Y Stretch
from Screen Layout Editor in @ Switch Page
ESD. However, changing their B ;
depth sort value from the property browser

will change the sequence.

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X X coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

Spacing Set the spacing gap between adjacent child widgets.
Orientation Set Linear Layout orientation. It supports:

e ESD_ORIENTATION_HORIZONTAL

e ESD_ORIENTATION_VERTICAL
Alignment Set the alignment setting for the child widgets in the layout
Overflow Set child widget overflow mode. It supports:

e ESD_OVERFLOW_ALLOW

¢ ESD_OVERFLOW_CLIP

e ESD_OVERFLOW_FILL
Scissor Set true to enable scissor to clip off overflow
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ChildClipping Set the flags when child clipping should check. It supports:
e ESD_CLIP_RENDER
e ESD_CLIP_UPDATE
e ESD_CLIP_IDLE
Auto Resize Set auto resize mode for this layout.
Table 15 - Linear Layout Properties

Linear Layout Implementation

1. Horizontal Layout

All  child widgets of a |linear layout with its orientation are set to
“ESD_ORIENTATION_HORIZONTAL". They will be distributed horizontally with some
spacing in between adjacent widgets. The layout used as in the example here has
parameters:

Orientation = ESD_ORIENTATION_HORIZONTAL
Spacing = 4

Align = ESD_ALIGN_TOPFILL

Overflow = ESD_OVERFLOW_ALLOW

2. Vertical Layout

All child widgets of a linear layout with its orientation set to
“ESD_ORIENTATION_VERTICAL". They will be distributed vertically
with some spacing in between adjacent widgets. The layout used as
in the example here has parameters:

e Orientation = ESD_ORIENTATION_VERTICAL
e Spacing = 4
e Align = ESD_ALIGN_TOPFILL ]
e Overflow SN - W UsesWidgetlwidget
ESD_OVERFLOW_ALLOW P Act .
= Connections
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The Stretch Layout is desighed = ESD Layouts
to work together with the i ranced
linear layout. In the event E
some widgets need to have
higher weightage in the layout,
Stretch Layouts are used.

Stretch

Pointer

Width
Height
Weight

Scroll Layout
Stretch
witch Page

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels

Y Y coordinate of the top-left of the widget, in pixels

Width Widget width

Height Widget Height

Weight The weight factor when determine the stretch scale in the

selected orientation
Table 16 - Stretch Layout Properties

Stretch Layout Implementation
1. Space Stretching

The example here demonstrates how to stretch unused space horizontally. A stretch layout
has been added into the Linear Layout. The weight factor used here is 1.

v Wl Widgets
* M Linear Layout

ESD Clock
2. Widget Weight Stretching
The example here demonstrates widget stretching. In this example, every clock widget

has different stretch weight values. The result every widget gains their proportion of width
as shown below -

@ £

Scroll Layout
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The Scroll Layout is a support runtime resizable and scrollable layout in ESD.

Jdvanced Pointer
Liilities
Fill Layout

Theme
Active
X

Fixed Positioning
Linear Layout

i Scroll Layout
Stretch

Switch Page

Height
Scroll.. hanged
Scroll.. hanged

Property Name Description

Pointer The pointer reference of the widget object

Active Enable or disable displaying this widget

X x coordinate of the top-left of the widget, in pixels
Y Y coordinate of the top-left of the widget, in pixels
Width Widget width

Height Widget Height

ScrollX Getter and Setter for scroll value along X-axis
ScrollY Getter and Setter for scroll value along Y-axis
Align Set alignment for its child widgets

Scrollbars Set when scrollbar should be visible

TouchScroll Set true to enable touch scroll

Scroll Bar Size To set scroll bar size when it is visible

Table 17 - Scroll Layout Properties

Scroll Layout Implementation

For the implementation of scroll layout, refer to the example project - “"EVE Screen
Desigher > Examples - Intermediate > ScrollPanel.
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Scroll Switch Page Layout

ESD Scroll Switch Page

The Scroll Switch Page Layout pp—
consists of a switch page manager and W Utiliti m O
a scroll panel for runtime scrollable | Fi _ ewRes U

§ Initial Previ...
support. ) Initial Current
Initial Next
Initial Index

Scroll Switch Page layout requires 3
lazy page instances and a current
index to start with, namely - the
previous page instance, the current
page instance and the next page
instance.

) Active Scroll
) Spinner

New Page
Active

N

Width
Height

Loop Pages
Count

Upon user touch swipe event, the
page will switch according to the

- . . . . Switch Speed
swipe direction. The behaviour of this s B

scroll switch page layout is as below: Current Page
Next Page

Current Index

¢ On non-swiping runtime, it only New Index
renders the current page, but
runs the update logic of all the 3 pages.

¢ On swiping event, it displays both the current page and the swiping to page (can be
previous and next page instance).

e On touch up event, it will either recover to the original position if the swiped range
has not reached the minimum threshold or switch to the new page. The touch scroll
will be temporally disabled until it has recovered or switched to the target page.

e Upon switching page complete, the scroll switch page will fire "NewPage” event and
requests a new page instance to be allocated and assigns it as the "New Page” input.

Figure 76 - Scroll Switch Page Layout

Property Name
Pointer

Initialise

Initial Previous
Initial Current
Initial Next
Initial Index
Active Scroll

Spinner

New Page
Active

X

Y

Width

Height

Loop Pages
Count
Spacing
Sensitivity
Switch Speed
Previous Page

Description

The pointer reference of the widget object

The “initialise” slot for initialling the scroll switch page layout
Initial Previous page instance at start

Initial Current page instance at start

Initial Next page instance at start

Initial Current page index at start

Set true to override child widgets touch tag event where tag is
default(255)

Set true to show spinner upon loading the new page instance.
New page instance input

Enable or disable displaying this widget

X coordinate of the top-left of the widget, in pixels

Y coordinate of the top-left of the widget, in pixels

Widget width

Widget Height

Set true to loop the pages

Set pages count/limit

Defines the spacing between pages

Define the scroll switch sensitivity, range from: 0.05 to 20.00
Define the switch speed during page transition

The output of previous page instance
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Current Page The output of current page instance
Next Page The output of next page instance
Current Index The output of current index

New Index The output of new index

Table 18 - Scroll Switch Page Layout Properties

Scroll Switch Page layout Implementation

In typical configuration for a scroll switch page layout, the figure below demonstrates a
sample setup. It should have the following rules:

e Connect start slot to the "Initialise” slot of scroll switch page layout instance.
All switching pages should be configured as child widgets of Scroll Switch Page.

e All child page widgets should be lazy allocation and has same width as the Scroll
Switch Page.

e [Initial Previous Page, Initial Current Page and the Initial Next Page should be active
by default while the rest of child pages should be inactive.

e Initial index should be the index of initial current page.

¢ Recommend using the “Switch” node to trigger the specific “Activate” signal of the
target page.

¢ Recommend using the “"Switch Value” node to get the specific target page instances
from all the pages.

¢ Recommend adding header and footer pages which are Sibling widgets of the Scroll
Switch Page Layout instance.

2] ;tatu Bar
> W Scroll S\Mtch Pagc

M PageFoo Ittr

Figure 77 - Sample Scroll Switch Page Implementation
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Signal Switch Page Layout

) Layvouts Signal Switch Pa
The Signal Switch Page Layout is a D;'ﬁ:t:j =
simplified layout of Scroll Switch Page _ O NextPagesig...
Layout which designed for the user case ch Widget Bl
which touch screen is not supported. Dynamic Switch Page
Initial Previ...
The same as Scroll Switch Page Layout, e EEE' C:::-rtmt

Initial Index

Signal Switch Page Layout requires 3
lazy page instances and a current index
to start with, namely - the previous
page instance, the current page
instance and the next page instance.

W scooll Layout
ﬂ Stretch

ij! Switch Page
B Scroll Switch Page
M Signal Switch Page

New Page
Active

X

Y

Width
Height

Switch Speed
2 slots, namely NextPageSignal and f:l:cntpw
PreviousPageSignal are provided for the LI AR TR Tl
user to switch to next or previous page. Previous Page
The signals to trigger the switch page st cey
can be a button trigger, or another T

signals.

Next Page

Figure 78 - Signal Switch Page Layout

Similar to Scroll Switch Page Layout, on swiping event (trigger by signal), it displays both
the current page and the swiping to page (can be previous and next page instance).

Property Name
Pointer
Initialise
Initial Previous
Initial Current
Initial Next
Initial Index
New Page
Active

X

Y

Width

Height

Loop Pages
Count

Spacing
Switch Speed
Previous Page
Current Page
Next Page
Current Index
New Index
Layout Direction
Shifting

Description

The pointer reference of the widget object

The “initialise” slot for initialling the scroll switch page layout
Initial Previous page instance at start

Initial Current page instance at start

Initial Next page instance at start

Initial Current page index at start

New page instance input

Enable or disable displaying this widget

x coordinate of the top-left of the widget, in pixels
Y coordinate of the top-left of the widget, in pixels
Widget width

Widget Height

Set true to loop the pages

Set pages count/limit

Defines the spacing between pages

Define the switch speed during page transition
The output of previous page instance

The output of current page instance

The output of next page instance

The output of current index

The output of new index

Choose between horizontally or vertically

Boolean value to show if page is in the middle of shifting or not

Table 19 - Signal Switch Page Layout Properties
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ESD Render Functions

All render functions are non-widget. They are not W ESD Render Functions
managed by layout in ESD 4.14. Non-widget functions are

to be used only within a widget. These functions are =
provided as utilities for user to make their own custom Jisplay Lis
widgets. ESD Theme

Note: In order to preview the render functions result in design time, render slot in the
custom widget is required.

Elements

The Elements are both simple and basic widgets, usually used
to construct higher level and more complex widgets.
Normally, they do not handle any touch input.

adient Panel
ELE

Panel Raized
Panel Sunken

Figure 79 - ESD Elements

ESD Circle

The Circle element allows the user to
draw circles on the screen. The following
styles are available - ESD Circle Flat;
ESD Circle Raised and ESD Circle
Sunken.

Figure 80 - ESD Circle Element

Property Name Description

Color RGB value to be rendered inside the circle
X x coordinate of central point, in pixels

Y Y coordinate of central point, in pixels
radius Radius of the point

Table 20 - ESD Circle Element Properties

ESD Panel

The ESD Panel is an adjustable rectangular
widget that defines a coloured area. The colour
can be specified by a theme or user’s selection.
Internally, it is constructed by EVE primitives
RECTS and SCISSORS. Two styles of ESD
Panel are available namely - ESD Panel Raised
and ESD Panel Sunken.

Figure 81 - ESD Panel Element
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Property Name Description

Theme Theme to be applied on the panel

X x coordinate of the top-left point, in pixels
y Y coordinate of the top-left point, in pixels
width Panel width

height Panel Height

radius radius of the corners

raised Set to true to make panel in raised style

Table 21 - ESD Panel Element Properties

ESD Gradient Panel

The Gradient Panel element is an B gl _
adjustable rectangular widget that z SR EREane
defines a gradient-coloured area. The :‘;ﬁdth

gradient colour can be specified by two height

colours (one at start and one at the end). radius

The gradient direction is adjustable by colorl

color2
direction
D raised

changing the direction.

Figure 82 - ESD Gradient Panel Element

Property Name Description

X x coordinate of the top-left point, in pixels
y Y coordinate of the top-left point, in pixels
width Panel width

height Panel Height

radius radius of the corners

colorl Start colour for gradient effect

color2 End colour for gradient effect

direction Gradient effect direction

raised Set to true to make panel in raised style

Table 22 - ESD Gradient Panel Element Properties

Primitives

A Primitive is a special type of logic node which is a
wrapper for a rendering function called by Render slot.
It has no return value and its properties cannot be output
to other logic nodes. Similar to widgets, it appears on
the screen, but is unable to handle user input.

e | [ I:l l_1ra|:||r—r1tF rtan;lcllnt:...
Figure 83 - Primitives b @ Display List
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ESD Bitmap

The ESD Bitmap object allows users to display a
bitmap resource. A bitmap resource is generated [
from an image file by adding it into a project. A
bitmap resource is treated as a single bitmap cell by
default with the name “(Bitmap Resource)_0".

For example, if the bitmap resource is named
“photo.jpg”, the default bitmap resource will be
named as “photo_0". Users can define how many
bitmap cells they want by specifying the "CellHeight”
property.

X

Library

50 Primitives

| E'_.D Bitmap Rotated
B ESD Bitmap S -alr.:-:I

50 Line (Fixed F'ulntl
5D Rectangle (Integer)
ESD Rectangle (Fixed Point)

Y
Btnep Cell
Color

Figure 84 - Bitmap Primitive

Property Name Description

X x coordinate of Bitmap, top-left, in pixels
y Y coordinate of Bitmap, top-left, in pixels
Bitmap Cell Bitmap cell to display

Color Color to be applied to bitmap

Table 23 - ESD Bitmap Properties

To add a bitmap

Click and select “File > Add” or click from the
toolbar. A bitmap cell is then assigned. ESD
4 14 supports the foIIowing image file formats as input -
“.png”, “.jpg” and “.jpeg”. Bitmap resources can contain a
single or multiple cells based on the CellHeight value.

If the value of the "CellHeight” is zero, then the number of
cells is one.

If the value of the "CellHeight” is non-zero, then the number
of cells value is calculated as shown below -

Number of Cell = Bitmap Height / CellHeight

Upon adding a Bitmap, the new bitmap resource will be
added into the library under the category - ‘User
Resources”.

Properties
Property

(Resource File Proxy)

Value
File Name Ducati_side_shadow....
Name Bitmap
Category
o ARGB1555
v True

Layouts
Render Functions
ESD Theme

Utilities
ESD Widgets
m Logic Flow
B LogicInterface
E! User Actors
E! User Functions
E! User Lapuut
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To use an ESD Bitmap, drag and drop the ESD Bitmap Node
into the Layout Editor or Logic Node Editor.

I8l ESD Primitives

tmap Rotated
tmap Scaled

=

. ne vint)
[#] ectangle (Integer)
. ESD Rectangle (|

Choose a Bitmap Cell to display from the dropdown list. Properties
Property Value

(ESD Bitmap)
MName ESD Bitmap
Active v True
Depth Sort 1.00
X 296
¥ 164
Bitmap Cell Iml1. 0

b Color . [255, 255, 255]

The list of Bitmap Cell values is updated automatically after a new image file is added into
a project.

a rendering function in ESD 4.14. Users are required to upgrade ESD Bitmap to

i 'j Use ESD Image to display bitmap as ESD bitmap is non-widget, and used only as
ESD Image from ESD 3.X.

ESD Line

The ESD Line allows users to draw lines on the ESD Linie {Iriteqer)
screen. 7

Figure 85 - ESD Line

only as a rendering function in ESD 4.14. Users are required to upgrade ESD Line

i 'j Use ESD Widgets - Line Widget to display line as ESD line is non-widget, and used
to Line Widget.
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Property Name Description

x0 x — coordinate of the start point, in pixels
yO0 y — coordinate of the start point, in pixels
x1 x — coordinate of the end point, in pixels
yl y — coordinate of the end point, in pixels
Width Line width, in pixel

Color Line color, in RGBA format

Table 24 - ESD Line Properties
Fixed Point Variant

ESD Line (Fixed point) expresses the properties with pixel attribute in fixed point format.
It provides more control to lines.

ESD Rectangle

The ESD Rectangle allows users to draw RSSENsClaals AT
rectangle on the screen. ¥

Figure 86 - ESD Rectangle

Property Name Description

X x coordinate of Bitmap, top-left, in pixels
Y Y coordinate of Bitmap, top-left, in pixels
width width, in pixels

height height, in pixels

radius radius of the round corner, in pixels
Color color of the rectangle

Table 25 - ESD Rectangle Properties

Fixed Point Variant

ESD Rectangle (Fixed point) expresses the properties with pixel attribute in fixed point
format. It provides more control to rectangles.

Display List

The Display List provides a collection of utilities functions related
to EVE Display List.

X_FORMAT

Figure 87 - ESD Display List
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ESD Theme

¥l ESD Theme
A Theme is a collection of colours which can be used across emes
the application in order to maintain a consistent style. The :
library browser provides the necessary logic nodes to make
most use of the theme function.

Figure 88 - Library Browser - ESD Theme

Built In Themes

ESD provides two Built-in Themes for users to configure the colour scheme of project.
They are: Ft_Esd _Theme_LightBlue theme and Ft_Esd_Theme_DarkOrange theme.

Theme_LightBle . theme

| ESD Theme
* U Themes
& Ft_Esd_Theme DarkQOrange

“® Ft Exd Theme LightBlue

Figure 89 - ESD Built-in Themes

Table 26 and Table 27 provides information about the built-in theme’s property -

Property Name Type Value (RGBA) Description
Name String Theme Ft_Esd_Theme_LightBlue
ClearColor RGBA 235,235,235(255) Clear Color
BackColor RGBA 255,255,255(255) Background Color
TextColor RGBA 0,0,0(255) Text Color
ButtonTextColor RGBA 250,250,250(255) Button Text Color
DefaultColor RGBA 113,113,113(255) Default Color
PrimaryColor RGBA 34,119,199(255) Primary Color
Table 26 - Ft_Esd_Theme_LightBlue Theme
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Property Name Type Value (RGBA) Description

Name String Theme Ft_Esd_Theme_DarkOrange
ClearColor RGBA 33,33,33(255) Clear Color

BackColor RGBA 21,21,21(255) Background Color
TextColor RGBA 255,255,255(255) Text Color

ButtonTextColor RGBA 255,255,255(255) Button Text Color
DefaultColor RGBA 107,107,107(255) Default Color

PrimaryColor RGBA 255,127,63(255) Primary Color

Table 27 - Ft_Esd_Theme_DarkOrange Theme

To create a new theme: File Edit Build Tools View Help
New F B Logic
1. Click and select “File > New -> E¥¥ M Actor
Theme”. f o osae B Widget
Close [ Page
= Save All % Theme

. S
New Project B Source Files

Open Project B Logic Source Files

§ i ) A ) Property Value
2. A new "*.theme” file is created within the Project folder. (Linked File Proxy)
Using the Property Editor, users can configure it as per Fibiars Ry thee e
Mame Theme

their requirement.

Category

Cl olor

PrimaryColor

3. The newly-created theme will be available across the EEEEE
project and may be applied it to other widgets with the gl Value
theme property. (ESD Label Butten)

MName

Active Ft_Ezd_Thesme_DarkOrang
Theme Ft_Esd_Theme GetCumen
i Ft_Esd_Theme LightBlue
¥

Width myFavonateTheme
Height 36

Font i)

Teut Labed Button

Primary
4. The newly created theme will also be available under User

Resources in the Library Browser. Users can drag and drop
the theme to the logic editor.
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ESD Utilities

ESD Utilities contains the collection ESD utilities functions. The
following table provides the

functionality.

ESD Utility

ESD BitmapCell GetInfo
ESD BitmapInfo GetHeight
ESD BitmapInfo GetWidth
Bitmap Persist

Color A+RGB Combine
Clamp Float

Get Delta Ms

Get Font Height

Get EVE Host

Get Milliseconds

ESD Idle Checker
Clamp Int16/UInt16
Clamp Int32/UInt32
Load Bitmap to RAM_G
Load Palette to RAM_G
Pop-up Spinner

Switch Bitmap Cell
ESD Timer

Touch Area

Touch Scroll

Touch Tag

Current Tag

Suppress Current Tags
Touch X/Y

Touch X/Y Delta

list of ESD Utilities and its

. Clamp Int1
P
B clampint32
B Load Bitmapto RAM G
B
| ¥

nmdPakﬁehnF.

~U Tuuch Area
¥ Touch Scroll
W Tuuch Tag

BN Touchv

B Touch ¥ Delta
| | Clamp Ulnt16
B Clamp Ulnt32

Description
Retrieves the BitmapCell information with given bitmap reference.
Returns the BitmapCell Height of given bitmap reference.
Retrieves the BitmapCell Width of given bitmap reference.
To persist the given bitmap object
Merge Alpha to RGB, to become RGBA colour
Clamp float value with min and max limits
Get Delta time difference in milliseconds since last frame update
called
Return Font Height
Get EVE Host
Get time in milli-seconds for current frame
Check when to sleep and wake up based on the touch events.
Clamp Int16/UInt16 value with min and max limits
Clamp Int32/UInt32 value with min and max limits
Load Bitmap to RAM_G
Load Palette to RAM_G
Pop-up Spinner when the frame is rendered
Switch Bitmap Cell
ESD Timer Actor
Touch Area Actor
Touch Scroll Actor
Touch Tag Actor
Current Touch Tag
Suppress Current Tags
Touch X/Y coordinate
Touch X/Y Delta
Table 28 - ESD Utilities & Description
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ESD Idle Checker

ESD Idle Checker Actor provides an actor to check when the application should go to sleep
mode or wake up —
from sleep mode. B RP
One of the main use '
cases of the idle
checker actor is to . e
check for idling and Bl Pages
wake up event for LR
displaying the screen
saver page. The IdicPage
picture on the right e e
demonstrated in
"AppScreen.page”
uses Idle Checker to
switch between
application pages
and the idle page. The idle checker has an interval of 250 ms and count of 60 intervals.
In other words, it may timeout when there is no touch event for 15 secs (60 * 250 =
15000 ms).

Logic Flow

A Logic Flow is an ESD built-in logic node. It is used to define the |Ekl&l]
logic or control flow and contains the following nodes: Frilte

Pointer

O (]

Iding

B ESD Layouts
= Condition 5| ESD Render Functions
B ESD Theme
o ESD Utilities
= Local Method I ESD Widgets

= Binary Condition

) Ll:u I v
* Binary Operator "_3:'L-nditi-r1

= Ternary Operator T Binary Condition
fx Local Method

" Unary Operator Binary Operator

=  Sequence
= Switch

Sequence

=  Switch Value Switch
. ritch Value
= Set Variable M copni
=  Watch Variables Watch Variables
E! User Actors
ﬂ User Functions
B UserGlobals
ﬂ User Pages
ﬂ User Resources
E User Widgets
Figure 90 - Logic Flow
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Library
'

Condition node provides a set Condition

of rules to be performed if a
certain condition is met. In
other words, it allows applying
decision points.

S0 Theme

SD Utilities

SO Widgets
Logic Flow
T Conditien

" Binary Condition

. Switch Value
: t Variable
M Watch Variables

Figure 91 - Logic Flow — Condition Node

Whenever a condition node is called, a "Then” condition will be called when the "If”
expression is True, otherwise an "E/se” condition will be called.

Ensure that the input for the “If” connection is a Boolean variable (i.e., True or False).

Binary Condition

Binary Condition node provides a set [==] Binary Condition
of rules to be performed based on the '

result of a binary operator on two input ] f]_c'ﬁw

values. In other words, it allows e, A
_ . . SD Utilities Right Value

applying decision points. B ESD Widgets T

Watch Variables

Figure 92 - Logic Flow - Binary Condition Node

Whenever a binary condition node is called, a "Then” condition will be called when the
result of binary operator on left and right value is True, otherwise an "E/se” condition will
be called.

The binary operator is specified by user and it will be evaluated when the node is called
through “Do” input call.
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Local Method

Local Method node is used to add a visual function node. It works as a place holder where
user will provide input using parameters and put the function body in logic editor. It gives
the option to specify the no. of parameters, parameter type and parameter name to the
function as input. User can select the parameter count using scroll bar and add parameters
(type and name) from the properties tab.

Library Properties
Property Value
| ESD Layouts {Local Method)
W ESD Render Functions Mame Local Method
| ESD Theme Type int
ESD Utilities Buffered False

il ESD Widgets S

Lagic Flow 0]

[0]
(1
[
Function Body

Binary Condition
% Local Method
Binary Operator
Ternary
Unary Operator
- Sequence
Switch
Switch Value
C" Set Variable
. Watch Variables
Local Method

Figure 93 - Logic Flow - Local Method

e “Parameter Type” - Type of input parameter to be selected from drop down menu
i.e., int, float, char* or Ft_Esd_Theme* etc.

e “Parameter Name” — Name of the variable should be according to ANSI C coding
standard.

e "Result” - Return value from this function which will be assigned to a variable or
input to new widget or assigned to output directly.
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Binary Operator

This node contains Binary Operator REZEE,
that operates on two operands [Ea-
(inputs) and manipulates them to
return an output. For example:
Result=Left Value * Right Value.

[+1 Binary Operator

Left Value
Right Value

Result

it

Logic Flow

=" Condition
Binary Condition
Binary Operator

Unary o perator

Sequence

M Watch Variables

Figure 94 - Logic Flow - Binary Operator Node
The following table provides a list of binary operators supported by ESD 4.14.

Binary Operator Description
== Equal to comparison operator

!:

Not Equal to comparison operator

&& Logical AND operator

& Binary AND operator

| Logical OR operator

| Logical OR operator

* Multiplication operator

/ Division operator

% Modulus operator

A Binary XOR operator

+ Addition operator

- Subtraction operator

, Comma operator

> Greater than operator

< Less than operator

>= Greater than or equal to
<= Less than or equal to

<< Binary Left Shift Operator
>> Binary Right Shift Operator

Table 29 - Binary Operators Supported by ESD 4.14
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Ternary Operator

Library

This node contains Ternary Operator - Temnary Operator
that operates on three arguments. First o eyouts |- Conditen Result
is the comparison argument; second is unctionsy | Value 1fTrue
the result upon a true comparison and i ESD Utilities Value If False

the third is the result upon a false
comparison.

For example: Result= condition
? "Value if true”: “Value if false”,

Unary Operator

[1] Unary Operator

This node contains Unary Operator that #R S = -
- i - Walue Result

operates on a single operand (input). For
example: ~.

Figure 96 - Logic Flow - Unary Operator Node

The following table provides a list of unary operators supported by ESD.

Unary Operator Description

! Logic Negation
& Address of

* De-reference

+ Positive operator

Negative operator

~ One’s complement

1 Non-zero value converts to 1and other values converts to 0.
Table 30 - Unary Operators Supported by ESD
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Sequence

“Sequence” node allows users [REEE

to define a series of calling RELEEMTN ts
actions. When the “Do” input H tender Functions
call is invoked, the calls will be i ESD Theme
triggered sequentially. The U ESD Utilities
number of calls is specified by
users in property “Count”.

Sequence

Properties
Value
(Sequence)
Mame Sequence

Count 0

Binary
Ternary Operator
Unary Operator
Sequence

ch

itch Value
t Varable
Watch Variables

Switch Node

“Switch” node will call different
branches based on the input [
value, like a “Switch-Case”
statement in C language. Users
can define any number of
branches and the values to be =
compared with input value i Loge Flow
through “Cases” property. Figure Condition
98 shows an example of 3
branches defined and called
respectively if input value is equal
to 1 or 2 or 3. Since, the input
value is pre-set to 4; the default
branch is called if no connection
is made on it.

i
)|

N
?
L

Watch Varnables

Figure 98 - Logic Flow - Switch Node
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Switch Value

“Switch Value” is a node REEG] Properties

to select one output » B ESD Layouts y Value
value  from multiple kP 1B ESD Render Functions

predefined values in Bl ESD Theme Switch Value
"Cases” property based B ESD Utilities

on input value. The B ESD Widgets o
example in Figure 99 Logic Flow i :
shows 2 “Cases” branch * Condition FEe
and property “Cases” 0 ™ Binary Condition N =
defines such logic: The erator [0] 1
“Result” value is 4 |if Ternary Operator [0] 4
input  value is 1. Unary Operator Al 3
Therefore, the result + Segquence 1] 5
value is 5 when the input Switch Default 0
value is 3. Switch Value

Set Variable Switch Value
Watch Variables
Switch Value

Valus

Default

Figure 99 - Logic Flow — Switch Value

Set Variable

The Set Variable node is used to RE:&EN Set Variable
set the values of a variable. It S EHIERTE

links an event call with a data » B ESD Render Functions

binding to a Writer (output a & ESD Theme

functional call through “writer”) B ESD Utilities

or a Variable (sets a variable to Il ESD Widgets

the value). 2 Logic Flow

= Condition
Binary Co
Binary Operator

Unary Operator

ot

M Ternary Operator
R e

. quence

itch Value
# ‘anabie
B ‘Watch Variables
Figure 100 - Logic Flow - Set Variable Node
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Watch Variables

Watch Variables

The Watch variables node is

used to monitor a set of W ESDLay _ - Changed [
variable updates. A single E:fg.Flfrj'?_e_r':”r'ct":'"s :
watch variable node can Bl
L ~ ESDr Litilities
monitor n number of

g . | ESD Widgets
variables which can be 5

‘ T Logic Flow
different (primitive) types. ™ Conditi
However, the more the input T Binary
variables have connected, M Binary Operator

the more frequent the output M Ternary Operator
“Changed” will be triggered. Y
User can also connect input
slots:
Set Variable
! Watch Vanables

Figure 101 - Logic Flow - Watch Variable Node

e "Check” - used to trigger an immediate check for the input variables against
previously checked values.

e "Reset” - set base values as current input values, and monitors changes from
there.

This watch variable could be very useful during the debugging, or multiple input trigger
events. It simplifies nested-if conditional flows.

Logic Interface

A Logic Interface is an ESD built-in logic node. It is used to Lit'faf_"f'

define an interface and contains the following nodes: » [ ESD Layouts

E5SD Render Functicns
ESD Theme

u

. gljpt'lfj)zt ESD Utl|lt|!.-_u

= Signal

" S/Ot_ ic Interface

= Variable Input

= Writer Cutput

» Widget Interface Signal

Slot
ariable

Figure 102 - Logic Interface
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Input

The Input node is used to create an input interface for its parent logic node to bind
incoming data. For instance, while creating a widget, an input node will define a property
for the widget whose value depends on the connection. Users can configure its property
through the Property Editor.

Library
» B EsD Layouts
ESD Render Functions| Properties
B ESD Theme Property Value
B ESD Utilities (input)
sD .'u"'n"idgEtE Mame Input

® Logic Flow Teplay Name

i logicInterface Comment
& Input Type
! [:]Utput Edit Role
F Signal Min
* Slot Max
& Variable Single Step
ﬁ Writer Default

Widget Interface

Figure 103 - Logic Interface - Input Node

The Output node is used to create an output interface for its parent logic to bind the
outgoing data. For instance, while creating a widget, an output node will define an interface
for the widget to display values to the users. Users can configure its property through the
Property Editor.

Library
kP ESD Layouts
I ESD Render Functions Properties
50 Theme Property

0 ESD Liilities (Dutput)
- i Output Aot
50 Widgets
Lo '"FI-.J-..
ogic Flow Display Name

Logic Interface
1 Input

Comment
Type

Value

' Variable
A Writer
' Widget Interface

Figure 104 - Logic Interface - Output Node
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Signal

The Signal node is used to create an outgoing event function call. Users can configure its
property through the Property Editor.

Library

b B ESD Layouts
ESD Render Functions
ESD Theme

ESD Utilities
ESD Properties

Value

Input Mame Signal
E output Display Name

Figure 105 - Logic Interface - Signal Node

The Slot node is used to create an incoming event function call.

Library
Pk

Signaled [
Input

=8 Output

¥ Signal

i Slat

' Variable
P er

' Widget Interface

Figure 106 - Logic Interface - Slot Node

Built-in Slot

There are a number of built-in slots available for Widgets, Pages and Applications which
are automatically called through the node hierarchy. The following table provides the list
of built-in slots.

Built-in Slot Description

Start Called when the node is created in memory

Render Writing rendering calls to the co-processor command buffer. It is
repeatedly called.

Update Called once before the frame render. It is called frequently.

Idle Called repeatedly while waiting for the frame to flip

End Called when the node is removed from the memory

Table 31 - Built-in Slots
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The following pseudo-code may help you understand how these slots are invoked:

//RApplication is booting up and started
Start ()
//Now UI is launched
while (UI is running)
{

Update() ;

Render () ;

Idle()
}
//Rpplication is ending
End()

Variable

The Variable node is used to define a plain C variable. Users can drag and drop the Variable

from the Library browser to the logic node editor and configure its property through the
Property Editor.

Library
B
Properties
Property VETS
(Variable)

Mame Variable

Input
Qutput
Signal

Display Mame

Comment

& Slot
Variable
Writer

get Interface

Type
Edit Role
hin

Mhax

Single Step

Value

Accessible from outside
the node

Accessible from outside
the node with no write

Only accessible from its
owner (Default)

Property Editor

Figure 107 - Logic Interface - Variable Node
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The Writer node is used to define a value writing interface for -
its parent node. Generally, it is used to setup the value for the e it

. . . . 20 Render Functions
external variable. For instance, while creating the ESD ESD Theme
Spinbox widget, the "Changed” writer is defined to update the D Utilities
connected external variables of Spinbox widget once Spinbox
value is changed.

c Interface
Input

Figure 108 - Logic Interface - Writer Node

Widget Interface

Library =
The Widget Interface node [N = SD Layouts Wndiet Toses ke
shows the interface of base SD Render Functions Pointer
widget interface. Since ESD B ESD Theme Container
4.0, all layouts, pages and <D Utilities Active
widgets have been SD Widgets Loical X
implemented from this e Fliom Local ¥
widget interface. For Soic Hiertace Loical Width
advanced users, this widget . : Loical Height
interface node could be Output Loical Rect
useful for designing user F:igr'lal Global ¥
customized widget in order % Siot Global ¥
to use its base interface for '--"a-riah e Global Width
accessing information from '.I-".-'rit-=r - Global Height
ESD widget framework. : = Global Rect

# Widget Interface
Figure 109 - Widget Interface

Property Name Description

Pointer Provides the pointer of this widget, allow other widget/layout/page to refer

Container Provides the pointer of this widget’s immediate container. Normally, a
widget’s immediate container is a layout

Active Set and get the current widget active

Local X Set and get the current widget local X. Local X refers to the local x-
coordinate with reference to its container

Local Y Set and get the current widget local Y. Local Y refers to the local y-
coordinate with reference to its container

Local Width Set and get the current widget local width. Local width refers to the
designed width with reference to its container

Local Height Set and get the current widget local height. Local height refers to the
designed height with reference to its container

Local Rect Set and get the current widget local dimension with reference to its
container

Global X Set and get the current widget global X. Global X refers to the global x-

coordinate with reference to screen
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Global Y Set and get the current widget global Y. Global Y refers to the global y-
coordinate with reference to screen

Global Width Set and get the current widget global width. Global width refers to the
designed width with reference to screen

Global Height Set and get the current widget global height. Global height refers to the
designed height with reference to screen

Global Rect Set and get the current widget global dimension with reference to its screen

Table 32 - Widget Interface Properties

« ' ¥ Advanced users are encouraged to refer the example project “WindowLayout”
for details.

e All Local properties are subjected to difference from the respective Global
properties. As the global values are determined by the layers of the layouts as
' containers.
(. i e Global properties are the values determined at the runtime. While Local
properties are values determined at design time.
e Global properties are eventually stable in runtime, as layers of layouts may
require multiple rendering cycle to stabilize.
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Property Editor

The Property Editor provides user a unified interface to edit :
properties. Each logic node in ESD, including a widget, has s ]k
its own predefined properties. Users can edit the property il Rl famon

values using the Property Editor to customize logic nodes. ;‘a"”f_ Eal badic Rotivs
repth Sort 0,00

Active v True

Theme Ft_Esd Theme_ G
X 0

Y 0

Width 20

Height 20

Font r

Text Option

The sample picture given below shows an example of the
ESD widget “"ESD Radio Button”.

Figure 110 - Property Editor

Common Properties

While each widget has its own properties defined for its own specific features, the following
are some of the properties that are commonly found in all the widgets of ESD application

= Name
= Depth Sort
= Active

e
Value Value

ESD Radio Button ESD Slider
0.00

v True
Ft_Esd_Theme
10

10

Ft_Esd_Theme_GetC
]
[i]

Width 20

Height 20

Font 27

Text Option

Height

Alpha

Value

Range

Figure 111 - ESD Common Properties

Product Page 115
Document Feedback Copyright © Bridgetek Pte Ltd



Bridgetek BRT_AN_029 EVE Screen Designer 4.19 User Guide
BRIDGING TECHNOLOGY Version 1.8

Document Reference No.: BRT_000218 Clearance No.: BRT#159

Each node must have one unique name as an identifier. ErEEa
Users are required to define a name that is valid C
identifier, since these names will be used by ESD for i
generating the source code. ESD Slider

Depth Sort 0.00

Active v True

Theme Ft_Esd Theme_GetC...

X

Y

Width

Height

Alpha

Value

Property Value

Range
Figure 112 - Name Property

Depth Sort

Properties

Each widget and page have one common property called

Depth Sort. Tt is of floating-point type, and defines the (s e .
sequence of rendering. The default value is *0.00” and Nam D Slider
users may change it accordingly to adjust the sequence 0.00

of the rendering process. ; vl
me Ft_Ezd Theme_GetC...

Width
Height

Alpha

Value

Range
Figure 113 - Depth Sort Property
|
The context menu helps users adjust the rendering
sequence without dealing with the values and can be
accessed within the layout editor by selecting the widget
or page and right-clicking it. i Bring to Front

Bring Forward

Send Backward

Send to Back

Figure 114 - Right Click Menu

The widget or page with the greatest positive "Depth Sort” value will be rendered last
and appear on the topmost layer.
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Active

Each widget has one Active property of Boolean type REEEE

which controls whether or not it is rendered on the screen. [ieEEn] Value
Active property in false state does not mean that the SR
widget is released from the memory. Instead, it means L
that the widget is not rendered on the screen, but still is
part of the memory.

ESD Slider

0.00

v True
Ft_Esd_Theme_Get(...

Width
Height

Alpha

Value
Range

Figure 115 - Active Property

« © ¥ Users must ensure that the Name property follows the standard C identifier
«~ .+ syntaxin order to make the generated source code more readable.

Programming Features

This section explains about the programming features. ESD enables users to write C code
and make this code available in the form of logic nodes so that the code can be re-used
across multiple projects.

Macros

In order to provide the development environment with necessary information about the
available functionality in a user’s code, ESD provides a set of macros. These macros are
necessary and useful when users add their own code that needs to be used from the /ogic
node editor or layout editor.

These macros are generally used together with the source code. It is recommended that
the user defines all the definitions associated with macros immediately following the
macros declarations where ever needed and in the same file. Not doing so, may result in
unexpected behaviour. For e.g., ESD_FUNCTION macro immediately needs to be followed
with function definition. Comments are acceptable between the macro and the definitions.

ESD_TYPE

ESD_TYPE provides information about a primitive type. All types are assumed to have a
default value of 0.

Syntax Example:

ESDfTYPE(ftiuint327t, Native = UInt32, Edit = Int)
ESD TYPE (char *, Native = Latinl, Edit = String)
ESD TYPE (Esd BitmapCell *, Native = Pointer, Edit = Library)
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Parameter Type Parameters Description

Native Type used internally for formatting C literals and
binary representations

Void Not a type (default)

Int64, Int32, Int16, Int | Signed integer

8,IntPtr

UInt64, UInt32, UInt16, | Unsigned integer

UInt8, UIntPtr

Double 64bit floating point

Float 32bit floating point

Char An 8bit text character

Bool C99 Bool

utf8 String with UTF-8 encoding

Latinl String with Latin 1 (ISO8859-1) encoding
Pointer Pointer type

Struct Struct type (not fully supported yet)

Edit Used by the Properties Editor to specify the control
to edit the value and by code generation when
using the fixed-point formats

None No editor control (default)

Int Integer, spin-box integer control

Real Floating point, spin-box floating point control
Boolean One or zero, checkbox

String Text, single-line entry

Fixed1, Fixed2, Fixed point, spin-box floating point control

..., Fixed32

ColorARGB Color, rgb with alpha

ColorRGB Color, rgb without alpha

Library Select a function specified with ESD_FUNCTION to

provide the value (useful for pointer values)

Table 33 - Macros - ESD_TYPE - Parameters

ESD_ENUM

Enumeration types are usable as types from the logic editor. It will use the specified
Type in the generated code. Internally, only the enumeration identifiers are parsed; values
are ignored. Enumerations used in the properties are serialized as their identifier string.
Enumerations are edited using a drop-down control in the Properties Editor.

Syntax Example:

Using pre-processor definitions, the symbol right after each #define statement is used.

ESD ENUM(Ft BitmapFormat, Type = ft uint32 t)
#define PALETTED 8UL
#define PALETTED4444 15UL
#define PALETTED565 14UL
#define PALETTEDS 16UL

ESD_END ()

Parsing from an enum requires the identifiers to be on separate lines, the first identifier of
each line is used.
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ESD ENUM(Ft BitmapFormat)

enum Ft BitmapFormat

{
PALETTED,
PALETTEDS65,
PALETTEDS

i

ESD_END ()

In case the enumeration is defined in another file, a macro is available to manually specify
the identifiers.

ESD ENUM(Ft BitmapFormat, Type = ft uint32 t)
ESD IDENTIFIER (PALETTED)
ESD_IDENTIFIER(PALETTED565)

ESD_END ()

When the Flag value is specified, the enumeration can combine multiple values, and will
show as a series of check-boxes in the Properties Editor instead of a drop-down menu.

ESD ENUM(Ft CoPro Opt, Type = ft uintl6 t, Flags)

#define OPT CENTERX 512UL B

ESD END()

To allow users to select 0 as a valid value, the Zero flag can be set. This flag has no effect
when the Flag value is specified.

ESD_PARAMETER

ESD_PARAMETER is a macro designed for the registration of user-defined parameters
within ESD. Whenever a user creates an ESD_FUNCTION or ESD_METHOD, they can
establish the parameter by utilizing ESD_PARAMETER.

Syntax Example:
ESD PARAMETER (value, Type = Int)

ESD PARAMETER (test, Type = ft bool t)
ESD PARAMETER (color, Type = ft argb32 t)

ESD_FUNCTION

ESD_FUNCTION is a macro to register a user defined function [t

to ESD, so that the application can add that function into the [l E~E ;a_ir"':;“_tﬂF o
User Functions category node which is located in the Library e TE:”:: SEREHONE
browser. ESD_FUNCTION is not applicable for static functions B ESD Utilities

even though ESD permits to make any function with B ESD Widgets

ESD_FUNCTION macro. % Logic Flow

& Logic Interface

Figure 116 - User Functions Example
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Syntax Example:
The following syntax example is to register a function called “hsvToRgb” to ESD.

ESD FUNCTION (hsvToRgb, Type = ft argb32 t )

ESD PARAMETER (h, Type = double)

ESD PARAMETER (s, Type = double)

ESD PARAMETER (v, Type = double)

ft argb32 t hsvToRgb (double h, double s, double v)

Upon registering the function, it is added to the User Functions category.

Parameters Description
Type The function’s return value type
Table 34 - Macros - ESD_FUNCTION - Parameters

e FEach ESD_PARAMETER defines only one function parameter. It must
be kept in a single line for each parameter.

e "Buffered” flag can be attached after toggleLED
“Type”. It will create the output of the
NOTE function stored in a member variable,
whenever the function is called.
Without the Buffered flag, you'll have
a function with just one output value which is called whenever the
output value is used. Here is an example:

ESD FUNCTION (toggleLED, Type=int,Buffered)
ESD PARAMETER (state, Type=ft bool t)

ESD_METHOD

ESD_METHOD works similar to ESD_FUNCTION with an enhanced feature. It takes a
logic/actor/widget/page/app context pointer as first parameter. It can be used only within
the logic editor of that logic/actor/widget/page/app.

Syntax Example:

The following syntax example defines one method to handle “Pushed” event for an ESD
Push Button widget contained in "MainPage.page”.

ESD METHOD (MainPage ESD Push Button Pushed, Context = MainPage)
void MainPage ESD Push Button Pushed (MainPage *context)
{
/7
1
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The logic node connection and the corresponding output is shown in the sample picture
below -

Library

ESD Push Button -~ 5 Panel

Dowen [
up O ESD Push Button Pushed

Pushed B—— @ cal m|

Width

Height

Font B output
Test ¥

Primany

Figure 117 - ESD_METHOD Example

Parameters Description
Context Pointing to the caller’s context
Table 35 - Meta Macros - ESD_METHOD - Parameters

e Additional parameters can be defined similar to ESD_FUNCTION. But
these parameters must be added only after the Context parameter.
Here is an example:

NOTE
O ESD Push Button Pushed
——rl’
teud
ESD METHOD (MainPage ESD Push Button Pushed, Context =
MainPage)
ESD PARAMETER (test, Type = ft bool t)
void MainPage ESD Push Button Pushed (MainPage
*context,ft bool t test)
{
//
1
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e If the return value of method function is to be defined, “Buffered”
keyword needs to be added after the “"Type” definition. Refer to the
syntax example -

ESD METHOD (MainPage ESD Push Button Pushed, Context =
NOTE MainPage, Type=int,Buffered)

ESD PARAMETER (test,Type = ft bool t)

int MainPage ESD Push Button Pushed(MainPage

*context, ft bool t test)

{

//
}

ESD_VARIABLE

ESD_VARIABLE is a built-in macro used to define a local variable of a logic node.
Syntax Example:

ESD VARIABLE (Margin, Type = ft intl6_t, Default = 0, Public)
ft intl6_t Margin;

ESD_GLOBAL

ESD_GLOBAL is a built-in macro used to define a global variable accessed across different
pages of a logic node. Global variable declaration should present in the header file and
definition should be in source file.

Syntax Example:

In header file:
ESD GLOBAL (Var, Type = int) // type must be specified
Extern int Var;

In C file:
Int Var = OxFFFF; // Assign initial value

ESD_INPUT

ESD_INPUT is a built-in macro used to define an input variable of a logic node.
Syntax Example:

ESD INPUT (Margin, Type = int)
int (* Margin) (void *context);

ESD_OUTPUT

ESD_OUTPUT is a built-in macro used to define an output variable of a logic node.
Syntax Example:

ESD OUTPUT (FirstPos, Type = int)
int LayoutSplit FirstPos(LayoutSplit *context);
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ESD_UPDATE

ESD _UPDATE macro is used to register a function that is called repeatedly by built-in
“Update” slot. This function shall not have any return value.

Syntax Example:
ESD UPDATE (Ft Esd BitmapPersist)

ESD PARAMETER (bitmapCell, Type = Ft Esd BitmapCell *)
void Ft Esd BitmapPersist (Ft Esd BitmapCell *bitmapCell);

Parameters:

Users can define their own parameter used by the registered function by using the
ESD_PARAMETER.

Pre-compiler options

Within the ESD C code simulation engine, the following macros are predefined in generated
source code:
e ESD SIMULATION

ESD_SIMULATION

ESD_SIMULATION macro is defined when the code is running through the ESD simulation
engine. If some part of the user’s C source code is not supposed to be run under the ESD
simulation engine, for example, accessing some hardware specific registers, users may
choose to skip the code by using this macro.

Add User Functions

Users can define their own functions by writing the C source code directly. If these
functions are defined by using the predefined "ESD_FUNCTION”, they will be shown under
the “User Functions” category in the library browser. Users can drag and drop these nodes
into the logic node editor to use them.

Creating Source File

Filee Edit Build Tools View

To add user functions, users need to create a C
source file by clicking File > New - Source
Files.

New

Upon adding the source file, include the following header (mandatory) in the source file.
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#include "Ft Esd.h"

Editing the Source File

To make ESD responsive of the user functions, the ESD specific macro "ESD_FUNCTION
or ESD_METHOD” needs to be added before the function definition. Refer to the examples
given below -

Syntax Example:

= Without parameter input and return value
ESD FUNCTION (BulbPage TestFunc)
void BulbPage TestFunc() {}

BulbPage_ TestFunc

[ call

=  Without parameter input, but with the return value

ESD FUNCTION (Ft Esd Theme GetCurrent, Type = Ft Esd Theme *)
Ft Esd Theme *Ft Esd Theme GetCurrent();

Current Theme

=  Without return value defined, but with the parameter input
ESD FUNCTION (Ft Esd Theme GetButtonTextColor, Type = ft rgb32 t)

ESD PARAMETER (theme, Type = Ft Esd Theme *)
ft rgb32 t Ft Esd Theme GetButtonTextColor (Ft Esd Theme *theme) { //.. }

pu_CoCmd_FgColor

=  Without return value and parameter input

ESD FUNCTION (Ft Esd Theme GetButtonTextColor, Type = ft rgb32 t)
ESD PARAMETER (theme, Type = Ft Esd Theme *)

ft rgb32 t Ft Esd Theme GetButtonTextColor (Ft Esd Theme *theme)
{

// ..
}
Get Button Text Color
theme
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